Safety warning notice

⚠️  WARNING!  To reduce the possibility of heat-related injuries or of overheating the device, do not place the device directly on your lap or obstruct the device air vents. Use the device only on a hard, flat surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to contact the skin or a soft surface, such as pillows or rugs or clothing, during operation. The device and the AC adapter comply with the user-accessible surface temperature limits defined by the International Standard for Safety of Information Technology Equipment (IEC 60950).
Table of contents

1 Product description ........................................................................................................................................ 1

2 External component identification ................................................................................................................ 5
   Display .................................................................................................................................................. 5
   Top ....................................................................................................................................................... 6
   Buttons and speakers .......................................................................................................... 6
   Keys ..................................................................................................................................... 7
   Lights ................................................................................................................................... 8
   TouchPad ...................................................................................................................... 9
   Left side .............................................................................................................................................. 10
   Right side ........................................................................................................................................... 11
   Bottom components ........................................................................................................................... 12

3 Illustrated parts catalog ............................................................................................................................... 13
   Service label ....................................................................................................................................... 13
   Computer major components ............................................................................................................. 14
   Display assembly subcomponents ..................................................................................................... 18
   Mass storage devices ......................................................................................................................... 19
   Miscellaneous parts ............................................................................................................................ 20
   Sequential part number listing ............................................................................................................ 20

4 Removal and replacement procedures ....................................................................................................... 24
   Preliminary replacement requirements ............................................................................................... 24
      Tools required .................................................................................................................... 24
      Service considerations ........................................................................................................ 24
         Plastic parts ......................................................................................................................... 24
         Cables and connectors ........................................................................................................ 24
         Drive handling .................................................................................................................. 25
      Grounding guidelines ......................................................................................................... 25
         Electrostatic discharge damage ........................................................................ 25
      Packaging and transporting guidelines ........................................................................ 27
   Component replacement procedures ................................................................................................. 28
      Service label ...................................................................................................................... 29
      Computer feet .................................................................................................................... 30
      Battery .................................................................................................................................... 31
      Service door .......................................................................................................................... 32
Optical drive ....................................................................................................................... 33
Hard drive ......................................................................................................................... 36
Replacing a hard drive ................................................................................................. 37
  Installing a hard drive with an operating system ........................................ 37
  Installing a hard drive without an operating system .................................. 38
Memory module ..................................................................................................................... 38
WLAN module .................................................................................................................... 41
Keyboard ............................................................................................................................... 43
Top cover ............................................................................................................................. 46
Speakers ............................................................................................................................... 49
Power button board .......................................................................................................... 50
TouchPad button board ..................................................................................................... 51
TouchPad LED board ......................................................................................................... 52
Display assembly ............................................................................................................... 52
Optical drive cable ............................................................................................................ 61
USB board .......................................................................................................................... 63
Power connector cable ....................................................................................................... 64
System board ...................................................................................................................... 65
RTC battery ......................................................................................................................... 67
Fan and heat sink ............................................................................................................... 68
PCH heat sink ..................................................................................................................... 71
Processor .............................................................................................................................. 72

5 Setup Utility (BIOS) and System Diagnostics ................................................................ 74
Using Setup Utility ............................................................................................................. 74
  Starting Setup Utility ..................................................................................................... 74
Changing the language of Setup Utility .......................................................................... 74
Navigating and selecting in Setup Utility ....................................................................... 75
Displaying system information ......................................................................................... 75
Restoring factory settings in Setup Utility ...................................................................... 76
Exiting Setup Utility ......................................................................................................... 76
Updating the BIOS ............................................................................................................ 76
  Determining the BIOS version ....................................................................................... 77
  Downloading a BIOS update ........................................................................................ 77
Using System Diagnostics ................................................................................................. 78

6 Specifications .................................................................................................................. 79
Computer specifications ................................................................................................. 79
35.6 cm (14.0 in), display specifications ............................................................................ 80
Hard drive specifications ................................................................................................. 80
DVD±RW SuperMulti Double-Layer Combo Drive specifications ................................... 81
# 1 Product description

<table>
<thead>
<tr>
<th>Category</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Product Name</strong></td>
<td>HP Pavilion g4 Notebook PC</td>
</tr>
<tr>
<td><strong>Processors</strong></td>
<td>2nd Generation Intel® Core™ processors:</td>
</tr>
<tr>
<td></td>
<td>- Intel Core i5-2450M processor (2.50 GHz, SC turbo up to 3.10 GHz, 1333 MHz/3.0 MB L3 cache, dual core, 35 W)</td>
</tr>
<tr>
<td></td>
<td>- Intel Core i3-2350M processor (2.30 GHz, 1333 MHz/3.0 MB L3 cache, dual core, 35 W)</td>
</tr>
<tr>
<td></td>
<td>- Intel Core i3-2330M processor (2.20 GHz, 1333 MHz/3.0 MB L3 cache, dual core, 35 W)</td>
</tr>
<tr>
<td></td>
<td>Intel Pentium® processor:</td>
</tr>
<tr>
<td></td>
<td>- Intel Pentium B960 processor (2.20 GHz, 1333 MHz/2.0 MB L3 cache, dual core, 35 W)</td>
</tr>
<tr>
<td><strong>Chipset</strong></td>
<td>Intel HM76 Express chipset</td>
</tr>
<tr>
<td><strong>Graphics</strong></td>
<td>Internal graphics (UMA):</td>
</tr>
<tr>
<td></td>
<td>- Intel HD Graphics 3000 on computer models equipped with a 2nd Generation Intel Core processor (Intel Core i5-2450M or i3), supports DX10</td>
</tr>
<tr>
<td></td>
<td>- Intel HD Graphics on computer models equipped with an Intel Pentium processor, supports DX10</td>
</tr>
<tr>
<td></td>
<td>Switchable discrete graphics:</td>
</tr>
<tr>
<td></td>
<td>- AMD Radeon HD 7670M with 2048 MB of dedicated video memory (128 MB×16 DDR3 @ 900 MHz × 8 modules); 128 bit M2 package, supports HD Decode, DX11, HDMI, PX5, and BACO</td>
</tr>
<tr>
<td></td>
<td>- AMD Radeon HD 7670M with 1024 MB of dedicated video memory (64 MB×16 DDR3 @ 900 MHz × 8 modules); 128 bit M2 package, supports HD Decode, DX11, HDMI, PX5, and BACO</td>
</tr>
<tr>
<td><strong>Display Panel</strong></td>
<td>35.6 cm (14.0 in), high-definition (HD), light-emitting diode (LED), SVA BrightView (1366×768) display; typical brightness: 200 cd/m² (nits)</td>
</tr>
<tr>
<td></td>
<td>All display assemblies include 2 wireless local area network (WLAN) antenna cables</td>
</tr>
<tr>
<td></td>
<td>Supports 16:9 ultra-wide aspect ratio</td>
</tr>
<tr>
<td><strong>Memory</strong></td>
<td>2 customer-accessible/upgradable memory module slots</td>
</tr>
<tr>
<td></td>
<td>Supports dual-channel memory</td>
</tr>
<tr>
<td></td>
<td>Supports up to 8192 MB of system RAM</td>
</tr>
<tr>
<td></td>
<td>DDR3-1333 MHz (DDR3-1600 downgrade to DDR3-1333), for a 2nd Generation Intel Core processor (Intel Core i5-2450M or Intel Core i3) or Pentium processor</td>
</tr>
<tr>
<td></td>
<td>Supports the following configurations:</td>
</tr>
<tr>
<td></td>
<td>- 8192 MB total system memory (4096×2)</td>
</tr>
<tr>
<td></td>
<td>- 6144 MB total system memory (4096×1 + 2048×1)</td>
</tr>
<tr>
<td></td>
<td>- 4096 MB total system memory (4096×1 or 2048×2)</td>
</tr>
<tr>
<td></td>
<td>- 2048 MB total system memory (2048×1)</td>
</tr>
<tr>
<td>Category</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Hard drives</td>
<td>Supports <strong>6.35 cm</strong> (2.5 in) hard drives in <strong>9.5 mm</strong> (.37 in) and <strong>7.0 mm</strong> (.28 in) thicknesses</td>
</tr>
<tr>
<td></td>
<td>Customer-accessible</td>
</tr>
<tr>
<td></td>
<td>Serial ATA (SATA)</td>
</tr>
<tr>
<td></td>
<td>Supports HP 3D Drive Guard</td>
</tr>
<tr>
<td></td>
<td>Supports the following single hard drive configurations:</td>
</tr>
<tr>
<td></td>
<td>• 1 TB, 5400 rpm, 9.5 mm</td>
</tr>
<tr>
<td></td>
<td>• 750 GB, 7200 rpm, 9.5 mm</td>
</tr>
<tr>
<td></td>
<td>• 750 GB, 5400 rpm, 9.5 mm</td>
</tr>
<tr>
<td></td>
<td>• 640 GB, 5400 rpm, 9.5 mm</td>
</tr>
<tr>
<td></td>
<td>• 500 GB, 7200 rpm, 9.5 mm</td>
</tr>
<tr>
<td></td>
<td>• 500 GB, 5400 rpm, 9.5 mm</td>
</tr>
<tr>
<td></td>
<td>• 320 GB, 7200 rpm, 7.0 mm</td>
</tr>
<tr>
<td></td>
<td>• 320 GB, 5400 rpm, 7.0 mm</td>
</tr>
<tr>
<td>Optical drive</td>
<td>Fixed</td>
</tr>
<tr>
<td></td>
<td>SATA</td>
</tr>
<tr>
<td></td>
<td>12.7 mm tray load</td>
</tr>
<tr>
<td></td>
<td>Customer-accessible</td>
</tr>
<tr>
<td></td>
<td>Supports Blu-ray ROM DVD±R/RW Super Multi Double-Layer Drive</td>
</tr>
<tr>
<td></td>
<td>Supports DVD±RW Super Multi Double-Layer Combo Drive</td>
</tr>
<tr>
<td></td>
<td>Supports zero-power optical drive</td>
</tr>
<tr>
<td>Audio and video</td>
<td>One digital microphone</td>
</tr>
<tr>
<td></td>
<td>HD audio</td>
</tr>
<tr>
<td></td>
<td>Supports Dolby Advanced Audio v2</td>
</tr>
<tr>
<td></td>
<td>2 Pavilion-branded Altec Lansing speakers</td>
</tr>
<tr>
<td></td>
<td>Supports Microsoft® Premium requirements</td>
</tr>
<tr>
<td>Ethernet</td>
<td>Integrated 10/100 network interface card (NIC)</td>
</tr>
<tr>
<td>Wireless</td>
<td>Integrated wireless local area network (WLAN) options by way of wireless module</td>
</tr>
<tr>
<td></td>
<td>Two WLAN antennas built into display assembly</td>
</tr>
<tr>
<td></td>
<td>Support for Intel Wireless Display and Wireless Music</td>
</tr>
<tr>
<td></td>
<td>Customer-accessible</td>
</tr>
<tr>
<td>Category</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Category</strong></td>
<td><strong>Description</strong></td>
</tr>
</tbody>
</table>
| **Support for the following WLAN formats:** | - Atheros 9485GN 802.11b/g/n 1×1 WiFi Adapter and 3012 Bluetooth 4.0 Combo Adapter (select models only)  
- Atheros HB125 802.11b/g/n 1×1 WiFi Adapter (select models only)  
- Broadcom 4313GN 802.11b/g/n 1×1 WiFi and 20702 Bluetooth 4.0 Combo Adapter  
- Broadcom 4313GN 802.11b/g/n 1×1 WiFi and 2070 Bluetooth 3.0+HS combination adapter (select models only)  
- Intel Centrino® Wireless-N 2230 802.11b/g/n 2×2 WiFi and Bluetooth Combo Adapter  
- Ralink RT5390BC8 802.11b/g/n 1×1 WiFi and Bluetooth 3.0+HS Combo Adapter  
- Ralink RT5390F 802.11b/g/n 1×1 WiFi Adapter                                                                                                                                                          |
| **External media card**          | HP Multi-Format Digital Media Reader supports the following digital card formats:  
- MultiMediaCard (MMC)  
- Secure Digital (SD) Memory Card  
- Secure Digital High Capacity (SDHC) Memory Card  
- Secure Digital Extended Capacity (SDXC) Memory Card                                                                                                                                               |
| **Internal media card**          | One half-size Mini Card slot for WLAN                                                                                                                                                                       |
| **Ports**                        | - Smart Pin AC power adapter  
- Audio-in (mono microphone)  
- Audio-out (stereo headphone)  
- HDMI version 1.4 supporting up to 1920×1200 @ 60Hz  
- RJ-45 (Ethernet, includes link and activity lights)  
- USB 3.0 (2 ports)  
- USB 2.0 (1 port)  
- VGA (Dsub 15 pin) supporting:  
  - 2048×1536 external resolution @ 75Hz  
  - Hot plug and unplug and auto-detection for correct output to wide-aspect vs. standard aspect video                                                                                             |
| **Keyboard/pointing devices**    | Full-size, textured, island-style keyboard  
- TouchPad with gesture support  
- Taps enabled by default                                                                                                                                                                               |
| **Power requirements**           | 90 W AC adapter with localized cable plug support (3-wire plug with ground pin, supports 3-pin DC connector) (for computer models equipped with a graphics subsystem with discrete memory only)  
65 W AC adapter with localized cable plug support (3-wire plug with ground pin, supports 3-pin DC connector) (for computer models equipped with a graphics subsystem with UMA memory only)  |
<table>
<thead>
<tr>
<th>Category</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Support for the following batteries:</td>
<td>Support for the following batteries:</td>
</tr>
<tr>
<td></td>
<td>● 6 cell, 2.20 Ah (47 Wh) Li-ion battery</td>
</tr>
<tr>
<td></td>
<td>● 6 cell, 2.55 Ah (55 Wh) Li-ion battery (select models only)</td>
</tr>
<tr>
<td>Supports fast charge</td>
<td>Supports fast charge</td>
</tr>
<tr>
<td>Security</td>
<td>Security cable slot</td>
</tr>
<tr>
<td>Operating system</td>
<td>Preinstalled:</td>
</tr>
<tr>
<td></td>
<td>● Microsoft Windows® 7 Home Professional 64 bit</td>
</tr>
<tr>
<td></td>
<td>● Windows 7 Home Premium 64 bit</td>
</tr>
<tr>
<td></td>
<td>● Windows 7 Home Basic 64 bit</td>
</tr>
<tr>
<td></td>
<td>● FreeDOS</td>
</tr>
<tr>
<td></td>
<td>● SUSE Linux</td>
</tr>
<tr>
<td>Serviceability</td>
<td>End-user replaceable parts:</td>
</tr>
<tr>
<td></td>
<td>● AC adapter</td>
</tr>
<tr>
<td></td>
<td>● Battery</td>
</tr>
<tr>
<td></td>
<td>● Hard drive</td>
</tr>
<tr>
<td></td>
<td>● Keyboard</td>
</tr>
<tr>
<td></td>
<td>● Memory modules (2)</td>
</tr>
<tr>
<td></td>
<td>● Optical drive</td>
</tr>
<tr>
<td></td>
<td>● WLAN module</td>
</tr>
</tbody>
</table>
2   External component identification

Display

<table>
<thead>
<tr>
<th>Item</th>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1)</td>
<td>WLAN antennas (2)*</td>
<td>Send and receive wireless signals to communicate with WLAN devices.</td>
</tr>
<tr>
<td>(2)</td>
<td>Internal microphone</td>
<td>Records sound.</td>
</tr>
<tr>
<td>(3)</td>
<td>Webcam</td>
<td>Records video and captures still photographs. To use the webcam, select Start &gt; All Programs &gt; CyberLink YouCam &gt; CyberLink YouCam.</td>
</tr>
<tr>
<td>(4)</td>
<td>Webcam light</td>
<td>On: The webcam is in use.</td>
</tr>
</tbody>
</table>

*The antennas are not visible from the outside of the computer. For optimal transmission, keep the areas immediately around the antennas free from obstructions. To see wireless regulatory notices, refer to the section of the Regulatory, Safety, and Environmental Notices that applies to your country or region. These notices are located in Help and Support.
### Top

**Buttons and speakers**

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
</table>
| (1) Power button | - When the computer is off, press the button to turn on the computer.  
- When the computer is on, press the button briefly to initiate Sleep.  
- When the computer is in the Sleep state, press the button briefly to exit Sleep.  
- When the computer is in Hibernation, press the button down briefly to exit Hibernation.  
**CAUTION:** Pressing and holding down the power button will result in the loss of unsaved information.  
If the computer has stopped responding and Microsoft Windows shutdown procedures are ineffective, press and hold the power button down for at least 5 seconds to turn off the computer.  
To learn more about your power settings, select **Start > Control Panel > System and Security > Power Options**, or see the *HP User Guide*. |
| 2 Speakers (2) | Produce sound. |
## Keys

![Keyboard Image](image)

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1) esc key</td>
<td>Displays system information when pressed in combination with the fn key.</td>
</tr>
<tr>
<td>(2) fn key</td>
<td>Displays system information when pressed in combination with the esc key.</td>
</tr>
<tr>
<td>(3) Operating system logo key</td>
<td>Displays the operating system menu.</td>
</tr>
<tr>
<td>(4) Action keys</td>
<td>Execute frequently used system functions.</td>
</tr>
<tr>
<td>(5) Operating system applications key</td>
<td>Displays a shortcut menu for items beneath the cursor.</td>
</tr>
</tbody>
</table>
# Lights

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
</table>
| (1) Power light     | - White: The computer is on.  
|                     | - Blinking white: The computer is in the Sleep state, which is an energy-saving mode. The computer shuts off power to the display and other unneeded components.  
|                     | - Off: The computer is off or in Hibernation. Hibernation is an energy-saving mode that uses the least amount of power.                       |
| (2) Caps lock light | White: Caps lock is on, which switches the keys to all capital letters.                                                                       |
| (3) Mute light      | - Amber: Computer sound is off.  
|                     | - Off: Computer sound is on.                                                                                                                  |
| (4) Wireless light  | - White: An integrated wireless device, such as a wireless local area network (WLAN) device and/or a Bluetooth® device, is on.             
|                     | - Amber: All wireless devices are off.                                                                                                         |
| (5) TouchPad light  | - Amber: The TouchPad is off.  
|                     | - Off: The TouchPad is on.                                                                                                                     |
# TouchPad

![TouchPad Diagram](image)

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1) TouchPad on/off button</td>
<td>Turns the TouchPad on or off.</td>
</tr>
</tbody>
</table>
| (2) TouchPad light | - Amber: The TouchPad is off.  
                     - Off: The TouchPad is on.                                              |
| (3) TouchPad zone | Moves the on-screen pointer and selects or activates items on the screen.  |
| (4) Left TouchPad button | Functions like the left button on an external mouse.                        |
| (5) Right TouchPad button | Functions like the right button on an external mouse.                       |
## Left side

![Left side image](image)

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1)</td>
<td>External monitor port</td>
</tr>
</tbody>
</table>
| (2) | Vents (2) | Enable airflow to cool internal components.  
**NOTE:** The computer fan starts up automatically to cool internal components and prevent overheating. It is normal for the internal fan to cycle on and off during routine operation. |
| (3) | HDMI port | Connects an optional video or audio device, such as a high-definition television, or any compatible digital or audio device. |
| (4) | RJ-45 (network) jack | Connects a network cable. |
| (5) | USB 3.0 ports (2) | Connect optional USB 3.0 compatible devices and provide enhanced USB power performance. |
| (6) | Audio-in (microphone) jack | Connects an optional computer headset microphone, stereo array microphone, or monaural microphone. |
| (7) | Audio-out (headphone) jack | Connects optional powered stereo speakers, headphones, earbuds, a headset, or a television audio cable.  
**WARNING!** To reduce the risk of personal injury, adjust the volume before using headphones, earbuds, or a headset. For additional safety information, see the *Regulatory, Safety and Environmental Notices*.  
**NOTE:** When a device is connected to a headphone jack, the computer speakers are disabled. |
| (8) | Digital Media Slot | Supports the following digital card formats:  
- Secure Digital (SD) Memory Card  
- Secure Digital Extended Capacity (SDxC) Memory Card  
- Secure Digital High Capacity (SDHC) Memory Card  
- MultiMediaCard (MMC) |
## Right side

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1) Optical drive</td>
<td>Reads and writes to an optical disc.</td>
</tr>
</tbody>
</table>
| (2) Optical drive light | ● Green or amber: The optical drive is being accessed.  
                          ● Off: The optical drive is idle.                                      |
| (3) Optical drive eject button | Releases the disc tray.                                                  |
| (4) Power light | ● White: The computer is on.  
                             ● Blinking white: The computer is in the Sleep state, which is an energy-saving mode. The computer shuts off power to the display and other unneeded components.  
                             ● Off: The computer is off or in Hibernation. Hibernation is an energy-saving mode that uses the least amount of power. |
| (5) Hard drive light | ● Blinking white: The hard drive is being accessed.  
                          ● Amber: HP 3D DriveGuard has temporarily parked the hard drive.     |
| (6) USB 2.0 port | Connects an optional USB 2.0 compatible device.                             |
| (7) AC adapter light | ● White: The AC adapter is connected and the battery is charged.  
                             ● Blinking white: The battery has reached a low battery level.  
                             ● Amber: The AC adapter is connected and the battery is charging.  
                             ● Off: The computer is using DC power.                             |
| (8) Power connector | Connects an AC adapter.                                                   |
| (9) Security cable slot | Attaches an optional security cable to the computer.  
                           **NOTE:** The security cable is designed to act as a deterrent, but it may not prevent the computer from being mishandled or stolen. |
# Bottom components

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1)</td>
<td>Battery bay</td>
</tr>
<tr>
<td>(2)</td>
<td>Battery release latch</td>
</tr>
<tr>
<td>(3)</td>
<td>Vents (5)</td>
</tr>
<tr>
<td>(4)</td>
<td>Keyboard access, optical drive, solid-state drive (SSD)/hard drive bay, wireless compartment, and memory module compartment</td>
</tr>
</tbody>
</table>

### Component (1): Battery bay
Holds the battery.

### Component (2): Battery release latch
Releases the battery from the battery bay.

### Component (3): Vents (5)
Enable airflow to cool internal components.

**NOTE:** The computer fan starts up automatically to cool internal components and prevent overheating. It is normal for the internal fan to cycle on and off during routine operation.

### Component (4): Keyboard access, optical drive, solid-state drive (SSD)/hard drive bay, wireless compartment, and memory module compartment
The service door provides access to the keyboard, optical drive, SSD/hard drive bay, wireless compartment and memory module compartment.

**CAUTION:** To prevent an unresponsive system, replace the wireless module only with a wireless module authorized for use in the computer by the governmental agency that regulates wireless devices in your country or region. If you replace the module and then receive a warning message, remove the module to restore computer functionality, and then contact customer support through Help and Support.
3  Illustrated parts catalog

Service label

When ordering parts or requesting information, provide the computer serial number and model description provided on the service label.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1)</td>
<td>Product name</td>
<td>This is the model name for the computer.</td>
</tr>
<tr>
<td>(2)</td>
<td>Serial number</td>
<td>This is an alphanumeric identifier that is unique to each product.</td>
</tr>
<tr>
<td>(3)</td>
<td>Product part number</td>
<td>This number provides specific information about the product's hardware components. The part number helps a service technician to determine what components and parts are needed.</td>
</tr>
<tr>
<td>(4)</td>
<td>Warranty period</td>
<td>This number describes the duration of the warranty period for the computer.</td>
</tr>
<tr>
<td>(5)</td>
<td>Model description (select models only)</td>
<td>This is the alphanumeric identifier needed to locate documents, drivers, and support for the computer.</td>
</tr>
</tbody>
</table>
Computer major components
<table>
<thead>
<tr>
<th>Item</th>
<th>Component</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1)</td>
<td>35.6 cm (14.0 in), high definition (HD), LED, BrightView display assembly (includes webcam, microphone, wireless antenna transceivers and cable):</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● Ruby Red 683845-001</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● Sparkling Black 683847-001</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● Winter Blue 683846-001</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> For more display assembly spare part information, see Display assembly subcomponents on page 18.</td>
<td></td>
</tr>
<tr>
<td>(2)</td>
<td><strong>Keyboard</strong> (includes keyboard cable):</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Keyboard with black finish:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● For use in Brazil 680555-201</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● For use in Canada 680555-DB1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● For use in India 680555-D61</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● For use in Japan 680555-291</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● For use in Latin America 680555-161</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● For use in South Korea 680555-AD1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● For use in Taiwan 680555-AB1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● For use in Thailand 680555-281</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● For use in the United States 680555-001</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Keyboard with white finish:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● For use in Brazil 684479-201</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● For use in Latin America 684479-161</td>
<td></td>
</tr>
<tr>
<td>(3)</td>
<td><strong>Top cover</strong> (includes TouchPad):</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● Ruby Red 680574-001</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● Sparkling Black 680576-001</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● Winter Blue 680575-001</td>
<td></td>
</tr>
<tr>
<td>(4)</td>
<td><strong>Power button board</strong> (includes cable)</td>
<td>680560-001</td>
</tr>
<tr>
<td>(5)</td>
<td><strong>TouchPad LED board</strong> (includes cable)</td>
<td>683848-001</td>
</tr>
<tr>
<td>(6)</td>
<td><strong>TouchPad button board</strong> (includes cable)</td>
<td>680559-001</td>
</tr>
<tr>
<td>(7)</td>
<td><strong>Speaker Kit</strong> (includes left and right speakers and cable)</td>
<td>680567-001</td>
</tr>
<tr>
<td>(8)</td>
<td><strong>System board</strong> (includes replacement thermal material):</td>
<td>680568-001</td>
</tr>
<tr>
<td></td>
<td>● For use only with computer models equipped with UMA video memory</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● For use only with computer models equipped with 2048 MB of dedicated discrete video memory</td>
<td>680570-001</td>
</tr>
<tr>
<td></td>
<td>● For use only with computer models equipped with 1024 MB of dedicated discrete video memory</td>
<td>680569-001</td>
</tr>
<tr>
<td>(9)</td>
<td><strong>Intel Platform Controller Hub (PCH) heat sink</strong></td>
<td>683843-001</td>
</tr>
<tr>
<td>Item</td>
<td>Component</td>
<td>Spare part number</td>
</tr>
<tr>
<td>------</td>
<td>-----------</td>
<td>-------------------</td>
</tr>
<tr>
<td>(10)</td>
<td>Processor (includes replacement thermal material):</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Intel Core i5-2450M processor (2.50 GHz, SC turbo up to 3.10 GHz, 1333 MHz/3.0 MB L3 cache, dual core, 35 W)</td>
<td>676359-001</td>
</tr>
<tr>
<td></td>
<td>Intel Core i3-2350M processor (2.30 GHz, 1333 MHz/3.0 MB L3 cache, dual core, 35 W)</td>
<td>653340-001</td>
</tr>
<tr>
<td></td>
<td>Intel Core i3-2330M processor (2.20 GHz, 1333 MHz/3.0 MB L3 cache, dual core, 35 W)</td>
<td>653339-001</td>
</tr>
<tr>
<td></td>
<td>Intel Pentium B960 processor (2.20 GHz, 1333 MHz/2.0 MB L3 cache, dual core, 35 W)</td>
<td>664662-001</td>
</tr>
<tr>
<td>(11)</td>
<td>RTC battery (includes cable and double-sided tape)</td>
<td>637193-001</td>
</tr>
<tr>
<td>(12)</td>
<td>Fan and heat sink (includes replacement thermal material):</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Heat sink for use only with computer models equipped with discrete video memory</td>
<td>680550-001</td>
</tr>
<tr>
<td></td>
<td>Heat sink for use only with computer models equipped with UMA video memory</td>
<td>680549-001</td>
</tr>
<tr>
<td></td>
<td>Fan</td>
<td>680551-001</td>
</tr>
<tr>
<td>(13)</td>
<td>Power connector cable</td>
<td>680548-001</td>
</tr>
<tr>
<td>(14)</td>
<td>USB board (includes cable)</td>
<td>680558-001</td>
</tr>
<tr>
<td>(15)</td>
<td>Optical drive cable (includes optical drive connector)</td>
<td>680546-001</td>
</tr>
<tr>
<td>(16)</td>
<td>Battery:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6 cell, 47 Whr, 2.20 Ah Li-ion battery</td>
<td>593553-001</td>
</tr>
<tr>
<td></td>
<td>6 cell, 55 Whr, 2.55 Ah Li-ion battery (select models only)</td>
<td>593554-001</td>
</tr>
<tr>
<td>(17)</td>
<td>Base enclosure</td>
<td>680544-001</td>
</tr>
<tr>
<td></td>
<td>Rubber Feet Kit (not illustrated, includes 4 rubber feet)</td>
<td>680563-001</td>
</tr>
<tr>
<td>(18)</td>
<td>Hard drive SATA, does not include hard drive bumpers, bracket, or cable):</td>
<td></td>
</tr>
<tr>
<td></td>
<td>9.5 mm (0.37 in) x 6.35 cm (2.50 in):</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1 TB, 5400 rpm</td>
<td>676521-001</td>
</tr>
<tr>
<td></td>
<td>750 GB, 7200 rpm</td>
<td>633252-001</td>
</tr>
<tr>
<td></td>
<td>750 GB, 5400 rpm</td>
<td>634250-001</td>
</tr>
<tr>
<td></td>
<td>640 GB, 5400 rpm</td>
<td>669300-001</td>
</tr>
<tr>
<td></td>
<td>500 GB, 7200 rpm</td>
<td>634925-001</td>
</tr>
<tr>
<td></td>
<td>500 GB, 5400 rpm</td>
<td>669299-001</td>
</tr>
<tr>
<td></td>
<td>7.0 mm (0.28 in) × 6.35 cm (2.50 in):</td>
<td></td>
</tr>
<tr>
<td></td>
<td>320 GB, 7200 rpm</td>
<td>634862-001</td>
</tr>
<tr>
<td></td>
<td>320 GB, 5400 rpm</td>
<td>645193-001</td>
</tr>
<tr>
<td></td>
<td>Hard Drive Hardware Kit includes hard drive bracket and bracket screws, cable, and 2 bumpers)</td>
<td>682745-001</td>
</tr>
<tr>
<td>(19)</td>
<td>Memory modules (2, DDR3, 10600, 1333 MHz):</td>
<td></td>
</tr>
<tr>
<td>Item</td>
<td>Component</td>
<td>Spare part number</td>
</tr>
<tr>
<td>------</td>
<td>-----------</td>
<td>-------------------</td>
</tr>
<tr>
<td></td>
<td>4 GB</td>
<td>641369-001</td>
</tr>
<tr>
<td></td>
<td>2 GB</td>
<td>652972-001</td>
</tr>
<tr>
<td>(20)</td>
<td>WLAN module:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Atheros 9485GN 802.11b/g/n 1×1 WiFi Adapter and 3012 Bluetooth 4.0 Combo Adapter (select models only)</td>
<td>655795-001</td>
</tr>
<tr>
<td></td>
<td>Atheros HB125 802.11b/g/n 1×1 WiFi Adapter (select models only)</td>
<td>675794-001</td>
</tr>
<tr>
<td></td>
<td>Broadcom 4313GN 802.11b/g/n 1×1 WiFi Adapter and 20702 Bluetooth 4.0+HS Combo Adapter</td>
<td>657325-001</td>
</tr>
<tr>
<td></td>
<td>Broadcom 4313GN 802.11b/g/n 1×1 WiFi and 2070 Bluetooth 3.0+HS combination adapter (select models only)</td>
<td>600370-001</td>
</tr>
<tr>
<td></td>
<td>Intel Centrino® Wireless-N 2230 802.11b/g/n 2×2 WiFi and Bluetooth Combo Adapter</td>
<td>670290-001</td>
</tr>
<tr>
<td></td>
<td>Ralink RT5390BC8 802.11b/g/n 1×1 WiFi and Bluetooth 3.0+HS Combo Adapter</td>
<td>656120-001</td>
</tr>
<tr>
<td></td>
<td>Ralink RT5390F 802.11b/g/n 1×1 WiFi Adapter</td>
<td>670691-001</td>
</tr>
<tr>
<td>(21)</td>
<td>Optical drive (includes bezel and bracket):</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Blu-ray ROM DVD±R/RW Super Multi Double-Layer Drive</td>
<td>680557-001</td>
</tr>
<tr>
<td></td>
<td>DVD±RW Super Multi Double-Layer Combo Drive</td>
<td>680556-001</td>
</tr>
<tr>
<td>(22)</td>
<td>Service door (includes 1 captive screw) — available in the Plastics Kit</td>
<td>680561-001</td>
</tr>
<tr>
<td></td>
<td>Rubber Kit (not illustrated, includes rubber feet)</td>
<td>680563-001</td>
</tr>
</tbody>
</table>
## Display assembly subcomponents

<table>
<thead>
<tr>
<th>Item</th>
<th>Component</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1)</td>
<td>Display bezel</td>
<td>680545-001</td>
</tr>
<tr>
<td>(2)</td>
<td>Webcam/microphone module</td>
<td>680577-001</td>
</tr>
<tr>
<td>(3)</td>
<td>Display Hinge Kit (includes left and right display hinges and brackets)</td>
<td>680554-001</td>
</tr>
<tr>
<td>(4)</td>
<td>35.6 cm (14.0 in), HD, LED, BrightView display panel</td>
<td>680562-001</td>
</tr>
<tr>
<td>(5)</td>
<td>Antenna Kit (includes left and right wireless antenna cables and transceivers)</td>
<td>680539-001</td>
</tr>
<tr>
<td>(6)</td>
<td>Display Panel Cable Kit (includes display panel cable)</td>
<td>680547-001</td>
</tr>
<tr>
<td>(7)</td>
<td>Display hinge covers (2)</td>
<td>680553-001</td>
</tr>
<tr>
<td>(8)</td>
<td>Display enclosure:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● Ruby Red</td>
<td>680541-001</td>
</tr>
<tr>
<td></td>
<td>● Sparkling Black</td>
<td>680543-001</td>
</tr>
<tr>
<td></td>
<td>● Winter Blue</td>
<td>680542-001</td>
</tr>
<tr>
<td></td>
<td><strong>Display Screw Kit</strong> (not illustrated)</td>
<td>680565-001</td>
</tr>
</tbody>
</table>
## Mass storage devices

### Optical drive (includes bezel and bracket):
- Blu-ray ROM DVD±R/RW Super Multi Double-Layer Drive 680557-001
- DVD±RW Super Multi Double-Layer Combo Drive 680556-001

### Hard drive SATA, does not include hard drive bumpers, bracket, or cable:

<table>
<thead>
<tr>
<th>Size</th>
<th>Component</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>9.5 mm (0.37 in) × 6.35 cm (2.50 in):</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>1 TB, 5400 rpm</td>
<td>676521-001</td>
</tr>
<tr>
<td></td>
<td>750 GB, 7200 rpm</td>
<td>633252-001</td>
</tr>
<tr>
<td></td>
<td>750 GB, 5400 rpm</td>
<td>634250-001</td>
</tr>
<tr>
<td></td>
<td>640 GB, 5400 rpm</td>
<td>669300-001</td>
</tr>
<tr>
<td></td>
<td>500 GB, 7200 rpm</td>
<td>634925-001</td>
</tr>
<tr>
<td></td>
<td>500 GB, 5400 rpm</td>
<td>669299-001</td>
</tr>
<tr>
<td>7.0 mm (0.28 in) × 6.35 cm (2.50 in):</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>320 GB, 7200 rpm</td>
<td>634862-001</td>
</tr>
<tr>
<td></td>
<td>320 GB, 5400 rpm</td>
<td>645193-001</td>
</tr>
</tbody>
</table>

### Hard Drive Hardware Kit, (not illustrated) includes:
- Hard drive bumpers (2)
- Hard drive bracket
- Hard drive cable

---

---
## Miscellaneous parts

<table>
<thead>
<tr>
<th>Component</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP Smart AC adapter</td>
<td></td>
</tr>
<tr>
<td>● 90 W HP Smart AC adapter with Power Factor Correction (PFC) (for computer models equipped with a graphics subsystem with discrete memory only)</td>
<td>609940-001</td>
</tr>
<tr>
<td>● 65 W HP Smart AC adapter with PFC (for computer models equipped with a graphics subsystem with UMA memory only)</td>
<td>609939-001</td>
</tr>
<tr>
<td>● 90 W HP Smart AC adapter with PFC (for select computer models equipped with a graphics subsystem with discrete memory only)</td>
<td>609947-001</td>
</tr>
<tr>
<td>● 65 W HP Smart AC adapter (for select computer models equipped with a graphics subsystem with UMA memory only)</td>
<td>609948-001</td>
</tr>
<tr>
<td>Power cord (3-pin, black, 1.83 m):</td>
<td></td>
</tr>
<tr>
<td>● For use in Argentina</td>
<td>490371-D01</td>
</tr>
<tr>
<td>● For use in Brazil</td>
<td>490371-202</td>
</tr>
<tr>
<td>● For use in Italy</td>
<td>490371-061</td>
</tr>
<tr>
<td>● For use in North America</td>
<td>490371-001</td>
</tr>
<tr>
<td>● For use in Europe</td>
<td>490371-021</td>
</tr>
<tr>
<td>● For use in India</td>
<td>490371-D61</td>
</tr>
<tr>
<td>● For use in Japan</td>
<td>490371-291</td>
</tr>
<tr>
<td>● For use in the People's Republic of China</td>
<td>490371-AA1</td>
</tr>
<tr>
<td>● For use in South Korea</td>
<td>490371-AD1</td>
</tr>
<tr>
<td>● For use in Taiwan</td>
<td>490371-AB1</td>
</tr>
<tr>
<td>● For use in Thailand</td>
<td>490371-201</td>
</tr>
<tr>
<td>● For use in the United Kingdom and Singapore</td>
<td>490371-031</td>
</tr>
<tr>
<td>Screw Kit</td>
<td>680566-001</td>
</tr>
</tbody>
</table>

## Sequential part number listing

<table>
<thead>
<tr>
<th>Spare part number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>490371-001</td>
<td>Power cord for use in North America (black, 3 in, 1.83 m)</td>
</tr>
<tr>
<td>490371-021</td>
<td>Power cord for use in Europe (black, 3 in, 1.83 m)</td>
</tr>
<tr>
<td>490371-031</td>
<td>Power cord for use in the United Kingdom and Singapore (black, 3 in, 1.83 m)</td>
</tr>
<tr>
<td>490371-061</td>
<td>Power cord for use in Italy (black, 3 in, 1.83 m)</td>
</tr>
<tr>
<td>490371-201</td>
<td>Power cord for use in Thailand (black, 3 in, 1.83 m)</td>
</tr>
<tr>
<td>490371-202</td>
<td>Power cord for use in Brazil (black, 3 in, 1.83 m)</td>
</tr>
<tr>
<td>490371-291</td>
<td>Power cord for use in Japan (black, 3 in, 1.83 m)</td>
</tr>
<tr>
<td>Spare part number</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>----------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>490371-AA1</td>
<td>Power cord for use in the People's Republic of China (black, 3 in, 1.83 m)</td>
</tr>
<tr>
<td>490371-AB1</td>
<td>Power cord for use in Taiwan (black, 3 in, 1.83 m)</td>
</tr>
<tr>
<td>490371-AD1</td>
<td>Power cord for use in South Korea (black, 3 in, 1.83 m)</td>
</tr>
<tr>
<td>490371-D01</td>
<td>Power cord for use in Argentina (black, 3 in, 1.83 m)</td>
</tr>
<tr>
<td>490371-D61</td>
<td>Power cord for use in India (black, 3 in, 1.83 m)</td>
</tr>
<tr>
<td>593553-001</td>
<td>6 cell, 47 Whr, 2.20 Ah Li-ion battery</td>
</tr>
<tr>
<td>593554-001</td>
<td>6 cell, 55 Whr, 2.55 Ah Li-ion battery (select models only)</td>
</tr>
<tr>
<td>600370-001</td>
<td>Broadcom 4313GN 802.11b/g/n 1x1 WiFi and 2070 Bluetooth 3.0+HS combination adapter (select models only)</td>
</tr>
<tr>
<td>609939-001</td>
<td>65 W HP Smart AC adapter with PFC (for computer models equipped with a graphics subsystem with UMA memory only)</td>
</tr>
<tr>
<td>609940-001</td>
<td>90 W HP Smart AC adapter with PFC (for computer models equipped with a graphics subsystem with discrete memory only)</td>
</tr>
<tr>
<td>609947-001</td>
<td>90 W HP Smart AC adapter with PFC (for select computer models equipped with a graphics subsystem with discrete memory only)</td>
</tr>
<tr>
<td>609948-001</td>
<td>65 W HP Smart AC adapter (for select computer models equipped with a graphics subsystem with UMA memory only)</td>
</tr>
<tr>
<td>645193-001</td>
<td>320 GB, 5400 rpm hard drive (7.0 mm (0.28 in) × 6.35 cm (2.50 in) SATA, does not include hard drive bumpers, bracket, or cable)</td>
</tr>
<tr>
<td>633252-001</td>
<td>750 GB, 7200 rpm hard drive (9.5 mm (0.37 in) × 6.35 cm (2.50 in) SATA, does not include hard drive bumpers, bracket, or cable)</td>
</tr>
<tr>
<td>634250-001</td>
<td>750 GB, 5400 rpm hard drive (9.5 mm (0.37 in) × 6.35 cm (2.50 in) SATA, does not include hard drive bumpers, bracket, or cable)</td>
</tr>
<tr>
<td>634862-001</td>
<td>320 GB, 7200 rpm hard drive (7.0 mm (0.28 in) × 6.35 cm (2.50 in) SATA, does not include hard drive bumpers, bracket, or cable)</td>
</tr>
<tr>
<td>634925-001</td>
<td>500 GB, 7200 rpm hard drive (9.5 mm (0.37 in) × 6.35 cm (2.50 in) SATA, does not include hard drive bumpers, bracket, or cable)</td>
</tr>
<tr>
<td>637193-001</td>
<td>RTC battery (includes cable and double-sided tape)</td>
</tr>
<tr>
<td>641369-001</td>
<td>4 GB memory module (DDR3, 10600, 1333 MHz)</td>
</tr>
<tr>
<td>652972-001</td>
<td>2 GB memory module (DDR3, 10600, 1333 MHz)</td>
</tr>
<tr>
<td>653339-001</td>
<td>Intel Core i3-2330M processor (2.20 GHz, 1333 MHz/3.0 MB L3 cache, dual core, 35 W; includes replacement thermal material)</td>
</tr>
<tr>
<td>653340-001</td>
<td>Intel Core i3-2350M processor (2.30 GHz, 1333 MHz/3.0 MB L3 cache, dual core, 35 W; includes replacement thermal material)</td>
</tr>
<tr>
<td>655795-001</td>
<td>Atheros 9485GN 802.11b/g/n 1×1 WiFi Adapter and 3012 Bluetooth 4.0 Combo Adapter (select models only)</td>
</tr>
<tr>
<td>656120-001</td>
<td>Ralink RT5390BC8 802.11b/g/n 1×1 WiFi and Bluetooth 3.0+HS Combo Adapter</td>
</tr>
<tr>
<td>657325-001</td>
<td>Broadcom 4313GN 802.11b/g/n 1×1 WiFi Adapter and 20702 Bluetooth 4.0+HS Combo Adapter</td>
</tr>
<tr>
<td>664662-001</td>
<td>Intel Pentium B960 processor (2.20 GHz, 1333 MHz/2.0 MB L3 cache, dual core, 35 W; includes replacement thermal material)</td>
</tr>
<tr>
<td>Spare part number</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>669299-001</td>
<td>500 GB, 5400 rpm hard drive (9.5 mm (0.37 in) × 6.35 cm (2.50 in) SATA, does not include hard drive bumpers, bracket, or cable)</td>
</tr>
<tr>
<td>669300-001</td>
<td>640 GB, 5400 rpm hard drive (9.5 mm (0.37 in) × 6.35 cm (2.50 in) SATA, does not include hard drive bumpers, bracket, or cable)</td>
</tr>
<tr>
<td>670290-001</td>
<td>Intel Centrino Wireless-N 2230 802.11b/g/n 2×2 WiFi and Bluetooth Combo Adapter</td>
</tr>
<tr>
<td>670691-001</td>
<td>Ralink RT5390F 802.11b/g/n 1×1 WiFi Adapter</td>
</tr>
<tr>
<td>675794-001</td>
<td>Atheros HB125 802.11b/g/n 1×1 WiFi Adapter (select models only)</td>
</tr>
<tr>
<td>676359-001</td>
<td>Intel Core i5-2450M processor (2.50 GHz, turbo up to 3.10 GHz; 1333 MHz/3.0 MB L3 cache, dual core, 35 W; includes replacement thermal material)</td>
</tr>
<tr>
<td>676521-001</td>
<td>1 TB, 5400 rpm hard drive (9.5 mm (0.37 in) × 6.35 cm (2.50 in) SATA, does not include hard drive bumpers, bracket, or cable)</td>
</tr>
<tr>
<td>680539-001</td>
<td>Antenna kit (includes left and right wireless antenna cables and transceivers)</td>
</tr>
<tr>
<td>680541-001</td>
<td>Display enclosure, Ruby Red</td>
</tr>
<tr>
<td>680542-001</td>
<td>Display enclosure, Winter Blue</td>
</tr>
<tr>
<td>680543-001</td>
<td>Display enclosure, Sparkling Black</td>
</tr>
<tr>
<td>680544-001</td>
<td>Base enclosure</td>
</tr>
<tr>
<td>680545-001</td>
<td>Display bezel</td>
</tr>
<tr>
<td>680546-001</td>
<td>Optical drive cable (includes optical drive connector)</td>
</tr>
<tr>
<td>680547-001</td>
<td>Display Panel Cable Kit (includes display panel cable and webcam/microphone module cable)</td>
</tr>
<tr>
<td>680548-001</td>
<td>Power connector cable</td>
</tr>
<tr>
<td>680549-001</td>
<td>Heat sink for use only with computer models equipped with a graphics subsystem with UMA video memory (includes replacement thermal material)</td>
</tr>
<tr>
<td>680550-001</td>
<td>Heat sink for use only with computer models equipped with a graphics subsystem with discrete video memory (includes replacement thermal material)</td>
</tr>
<tr>
<td>680551-001</td>
<td>Fan</td>
</tr>
<tr>
<td>680553-001</td>
<td>Display hinge covers (2)</td>
</tr>
<tr>
<td>680554-001</td>
<td>Display Hinge Kit (includes left and right display hinges and brackets)</td>
</tr>
<tr>
<td>680555-001</td>
<td>Keyboard with black finish for use in the United States (includes cable)</td>
</tr>
<tr>
<td>680555-161</td>
<td>Keyboard with black finish for use in Latin America (includes cable)</td>
</tr>
<tr>
<td>680555-201</td>
<td>Keyboard with black finish for use in Brazil (includes cable)</td>
</tr>
<tr>
<td>680555-281</td>
<td>Keyboard with black finish for use in Thailand (includes cable)</td>
</tr>
<tr>
<td>680555-291</td>
<td>Keyboard with black finish for use in Japan (includes cable)</td>
</tr>
<tr>
<td>680555-AB1</td>
<td>Keyboard with black finish for use in Taiwan (includes cable)</td>
</tr>
<tr>
<td>680555-AD1</td>
<td>Keyboard with black finish for use in South Korea (includes cable)</td>
</tr>
<tr>
<td>680555-D61</td>
<td>Keyboard with black finish for use in India (includes cable)</td>
</tr>
<tr>
<td>680555-DB1</td>
<td>Keyboard with black finish for use in Canada (includes cable)</td>
</tr>
<tr>
<td>680556-001</td>
<td>DVD±RW Super Multi Double-Layer Combo Drive (includes bezel and bracket)</td>
</tr>
<tr>
<td>Spare part number</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>680557-001</td>
<td>Blu-ray ROM DVD±R/RW Super Multi Double-Layer Drive (includes bezel and bracket)</td>
</tr>
<tr>
<td>680558-001</td>
<td>USB board (includes cable)</td>
</tr>
<tr>
<td>680559-001</td>
<td>TouchPad button board (includes cable)</td>
</tr>
<tr>
<td>680560-001</td>
<td>Power button board (includes cable)</td>
</tr>
<tr>
<td>680561-001</td>
<td>Plastics Kit (includes service door)</td>
</tr>
<tr>
<td>680562-001</td>
<td>35.6 cm (14.0 in), HD, LED, BrightView display panel</td>
</tr>
<tr>
<td>680563-001</td>
<td>Rubber Feet Kit (includes 4 rubber feet)</td>
</tr>
<tr>
<td>680565-001</td>
<td>Display Screw Kit</td>
</tr>
<tr>
<td>680566-001</td>
<td>Screw Kit</td>
</tr>
<tr>
<td>680567-001</td>
<td>Speaker Kit (includes left and right speakers and cable)</td>
</tr>
<tr>
<td>680568-001</td>
<td>System board for use only with computer models equipped with UMA video memory (includes replacement thermal material)</td>
</tr>
<tr>
<td>680569-001</td>
<td>System board for use only with computer models equipped with a graphics subsystem with 1024 MB of discrete video memory (includes replacement thermal material)</td>
</tr>
<tr>
<td>680570-001</td>
<td>System board for use only with computer models equipped with a graphics subsystem with 2048 MB of discrete video memory (includes replacement thermal material)</td>
</tr>
<tr>
<td>680571-001</td>
<td>Thermal Material Kit (includes replacement thermal paste and pads)</td>
</tr>
<tr>
<td>680574-001</td>
<td>Top cover, Ruby Red (includes TouchPad)</td>
</tr>
<tr>
<td>680575-001</td>
<td>Top cover, Winter Blue (includes TouchPad)</td>
</tr>
<tr>
<td>680576-001</td>
<td>Top cover, Sparkling Black (includes TouchPad)</td>
</tr>
<tr>
<td>680577-001</td>
<td>Webcam/microphone module</td>
</tr>
<tr>
<td>682745-001</td>
<td>Hard Drive Hardware Kit (includes hard drive bracket and bracket screws, cable, and 2 bumpers)</td>
</tr>
<tr>
<td>683843-001</td>
<td>PCH heat sink</td>
</tr>
<tr>
<td>683845-001</td>
<td>35.6 cm (14.0 in), HD, LED, BrightView display assembly, Ruby Red (includes webcam, microphone, wireless antenna transceivers and cable, and display cable)</td>
</tr>
<tr>
<td>683846-001</td>
<td>35.6 cm (14.0 in), HD, LED, BrightView display assembly, Winter Blue (includes webcam, microphone, wireless antenna transceivers and cable, and display cable)</td>
</tr>
<tr>
<td>683847-001</td>
<td>35.6 cm (14.0 in), HD, LED, BrightView display assembly, Sparkling Black (includes webcam, microphone, wireless antenna transceivers and cable, and display cable)</td>
</tr>
<tr>
<td>683848-001</td>
<td>TouchPad LED board (includes cable)</td>
</tr>
<tr>
<td>684479-161</td>
<td>Keyboard with white finish for use in Latin America</td>
</tr>
<tr>
<td>684479-201</td>
<td>Keyboard with white finish for use in Brazil</td>
</tr>
</tbody>
</table>
4 Removal and replacement procedures

Preliminary replacement requirements

Tools required

You will need the following tools to complete the removal and replacement procedures:

- Flat-bladed screwdriver
- Magnetic screwdriver
- Phillips P0 and P1 screwdrivers

Service considerations

The following sections include some of the considerations that you must keep in mind during disassembly and assembly procedures.

NOTE: As you remove each subassembly from the computer, place the subassembly (and all accompanying screws) away from the work area to prevent damage.

Plastic parts

WARNING: Using excessive force during disassembly and reassembly can damage plastic parts. Use care when handling the plastic parts. Apply pressure only at the points designated in the maintenance instructions.

Cables and connectors

WARNING: When servicing the computer, be sure that cables are placed in their proper locations during the reassembly process. Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat or seat the cables during removal and insertion. Handle cables by the connector whenever possible. In all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in such a way that they cannot be caught or snagged by parts being removed or replaced. Handle flex cables with extreme care; these cables tear easily.
Drive handling

⚠️ **CAUTION:** Drives are fragile components that must be handled with care. To prevent damage to the computer, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive, avoid touching the connector.

Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and be sure that the optical drive tray is closed.

Handle drives on surfaces covered with at least one inch of shock-proof foam.

Avoid dropping drives from any height onto any surface.

After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.

Avoid exposing an internal hard drive to products that have magnetic fields, such as monitors or speakers.

Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective packaging and label the package “FRAGILE.”

Grounding guidelines

**Electrostatic discharge damage**

Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure determine the degree of sensitivity. Networks built into many integrated circuits provide some protection, but in many cases, ESD contains enough power to alter device parameters or melt silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a normal cycle. Or the device may function normally for a while, then degrade in the internal layers, reducing its life expectancy.

⚠️ **CAUTION:** To prevent damage to the computer when you are removing or installing internal components, observe these precautions:

Keep components in their electrostatic-safe containers until you are ready to install them.

Before touching an electronic component, discharge static electricity by using the guidelines described in this section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by different activities.

⚠️ **CAUTION:** A product can be degraded by as little as 700 V.
## Typical electrostatic voltage levels

<table>
<thead>
<tr>
<th>Event</th>
<th>Relative humidity</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>10%</td>
</tr>
<tr>
<td>Walking across carpet</td>
<td>35,000 V</td>
</tr>
<tr>
<td>Walking across vinyl floor</td>
<td>12,000 V</td>
</tr>
<tr>
<td>Motions of bench worker</td>
<td>6,000 V</td>
</tr>
<tr>
<td>Removing DIPS from plastic tube</td>
<td>2,000 V</td>
</tr>
<tr>
<td>Removing DIPS from vinyl tray</td>
<td>11,500 V</td>
</tr>
<tr>
<td>Removing DIPS from Styrofoam</td>
<td>14,500 V</td>
</tr>
<tr>
<td>Removing bubble pack from PCB</td>
<td>26,500 V</td>
</tr>
<tr>
<td>Packing PCBs in foam-lined box</td>
<td>21,000 V</td>
</tr>
</tbody>
</table>
Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

- To avoid hand contact, transport products in static-safe tubes, bags, or boxes.
- Protect ESD-sensitive parts and assemblies with conductive or approved containers or packaging.
- Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.
- Place items on a grounded surface before removing items from their containers.
- Always be properly grounded when touching a component or assembly.
- Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive foam.
- Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that mechanized equipment used for moving materials is wired to ground and that proper materials are selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate electric charges.

Workstation guidelines

Follow these grounding workstation guidelines:

- Cover the workstation with approved static-shielding material.
- Use a wrist strap connected to a properly grounded work surface and use properly grounded tools and equipment.
- Use conductive field service tools, such as cutters, screwdrivers, and vacuums.
- When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe materials.
- Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids and Styrofoam.
- Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle these items only at static-free workstations.
- Avoid contact with pins, leads, or circuitry.
- Turn off power and input signals before inserting or removing connectors or test equipment.
Equipment guidelines

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

- When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps with a minimum of one megohm ±10% resistance in the ground cords. To provide proper ground, wear a strap snugly against the skin at all times. On grounded mats with banana-plug connectors, use alligator clips to connect a wrist strap.

- When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps) can be used at standing workstations and are compatible with most types of shoes or boots. On conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one megohm resistance between the operator and ground. To be effective, the conductive must be worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:

- Antistatic tape
- Antistatic smocks, aprons, and sleeve protectors
- Conductive bins and other assembly or soldering aids
- Nonconductive foam
- Conductive tabletop workstations with ground cords of one megohm resistance
- Static-dissipative tables or floor mats with hard ties to the ground
- Field service kits
- Static awareness labels
- Material-handling packages
- Nonconductive plastic bags, tubes, or boxes
- Metal tote boxes
- Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

<table>
<thead>
<tr>
<th>Material</th>
<th>Use</th>
<th>Voltage protection level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Antistatic plastics</td>
<td>Bags</td>
<td>1,500 V</td>
</tr>
<tr>
<td>Carbon-loaded plastic</td>
<td>Floor mats</td>
<td>7,500 V</td>
</tr>
<tr>
<td>Metallized laminate</td>
<td>Floor mats</td>
<td>5,000 V</td>
</tr>
</tbody>
</table>

Component replacement procedures

This chapter provides removal and replacement procedures.

There are as many as 63 screws that must be removed, replaced, or loosened when servicing the computer. Make special note of each screw and screw lock size and location during removal and replacement.
Service label

When ordering parts or requesting information, provide the computer serial number and model number provided on the service label.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1)</td>
<td>Product name</td>
<td>The name affixed to the front of the computer.</td>
</tr>
<tr>
<td>(2)</td>
<td>Serial number (s/n)</td>
<td>This is an alphanumeric identifier that is unique to each product.</td>
</tr>
<tr>
<td>(3)</td>
<td>Part number/Product number (p/n)</td>
<td>This number provides specific information about the product's hardware components. The part number helps a service technician to determine what components and parts are needed.</td>
</tr>
<tr>
<td>(4)</td>
<td>Warranty period</td>
<td>This number describes the duration of the warranty period for the computer.</td>
</tr>
<tr>
<td>(5)</td>
<td>Model description (select models only)</td>
<td>This is the alphanumeric identifier needed to locate documents, drivers, and support for the computer.</td>
</tr>
</tbody>
</table>
The computer feet are adhesive-backed rubber pads. There are 4 rubber feet that attach to the base enclosure in the locations illustrated below.
Battery

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>6-cell, 55-Whr, 2.55-Ah Li-ion battery</td>
<td>593554-001</td>
</tr>
<tr>
<td>6-cell, 47-Whr, 2.20-Ah Li-ion battery</td>
<td>593553-001</td>
</tr>
</tbody>
</table>

Before disassembling the computer, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.
2. Disconnect all external devices connected to the computer.
3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then unplugging the AC adapter from the computer.

Remove the battery:

1. Slide the battery release latch (1) to release the battery.
2. Pivot the front edge of the battery (2) up and back.
3. Remove the battery (3) from the computer.

To insert the battery:

1. Align the tabs on the rear edge of the battery (1) with the notches on the rear edge of the battery bay.
2. Pivot the front edge of the battery (2) down into the battery bay until it is seated. (The battery release latch will automatically lock into place.)
Service door

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plastics Kit (contains the service door)</td>
<td>680561-001</td>
</tr>
</tbody>
</table>

Before removing the service door, remove the battery (see Battery on page 31).

1. Using a small Phillips screwdriver, loosen the service door screw (1).
2. Slide the service door (2) forward slightly and lift the front right corner (3) to tilt the service door.
3. Remove the service door (4) at an angle.

Reverse this procedure to replace the service door.
Optical drive

NOTE: The optical drive spare part kit includes a bezel and bracket.

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blu-ray ROM DVD±R/RW Super Multi Double-Layer Drive</td>
<td>680557-001</td>
</tr>
<tr>
<td>DVD±RW and CD-RW Super Multi Double-Layer Combo Drive</td>
<td>680556-001</td>
</tr>
</tbody>
</table>

Before removing the optical drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.
2. Disconnect all external devices connected to the computer.
3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then unplugging the AC adapter from the computer.
4. Remove the battery (see Battery on page 31).
5. Remove the service door (see Service door on page 32).

Remove the optical drive:

1. Using a small Phillips screwdriver, remove the Phillips M2.5 x 6.5 screw (1) that secures the optical drive to the computer.
2. Insert a screwdriver or other narrow tool through the release access hole (2) in the bottom of the computer. Push the rear of the optical drive until it is released.
3. Pull the optical drive (3) out from the front until the optical drive is completely removed from the computer.

4. Remove the two Phillips M2.0 x 3.0 screws (1) that secure the optical drive bracket to the optical drive and then remove the bracket (2) from the optical drive.
5. Insert a straightened paper clip (1) into the release access opening in the bezel.
6. Press the release tab (2) and remove the bezel from the tab side (3).
7. Remove the bezel (4) from the optical drive.

Reverse this procedure to reassemble and install the optical drive.
Hard drive

**NOTE:** If your replacement hard drive was shipped without an operating system installed, you will need to install it using the system recovery discs. See Installing a hard drive without an operating system on page 38.

If your replacement hard drive shipped with an operating system (image) installed, system recovery discs are not required for setup. See Installing a hard drive with an operating system on page 37.

**NOTE:** The hard drive spare part kit does not include the hard drive cable, hard drive bumpers, or hard drive bracket and screws.

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>9.5 mm (0.37 in) × 6.35 cm (2.50 in) SATA</td>
<td></td>
</tr>
<tr>
<td>1 TB, 5400 rpm</td>
<td>676521-001</td>
</tr>
<tr>
<td>750 GB, 7200 rpm</td>
<td>633252-001</td>
</tr>
<tr>
<td>750 GB, 5400 rpm</td>
<td>634250-001</td>
</tr>
<tr>
<td>640 GB, 5400 rpm</td>
<td>669300-001</td>
</tr>
<tr>
<td>500 GB, 7200 rpm</td>
<td>634925-001</td>
</tr>
<tr>
<td>500 GB, 5400 rpm</td>
<td>669299-001</td>
</tr>
<tr>
<td>7.0 mm (0.28 in) × 6.35 cm (2.50 in) SATA</td>
<td></td>
</tr>
<tr>
<td>320 GB, 7200 rpm</td>
<td>634862-001</td>
</tr>
<tr>
<td>320 GB, 5400 rpm</td>
<td>645193-001</td>
</tr>
<tr>
<td>Hard drive hardware kit (includes hard drive cable, hard drive bumpers, and hard drive bracket and screws)</td>
<td>682745-001</td>
</tr>
</tbody>
</table>

Before removing the hard drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.
2. Disconnect all external devices connected to the computer.
3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then unplugging the AC adapter from the computer.
4. Remove the battery (see Battery on page 31).
5. Remove the service door (see Service door on page 32).

Remove the hard drive:

1. Disconnect the hard drive cable (1) from the computer.
2. Lift the hard drive (2) to remove.

3. Disconnect the hard drive cable (1). Remove the front bumper (2) and back bumper (3).

4. Remove the four Phillips M3.0×3.5 screws (4), and then remove the bracket (5) from the hard drive.

Replacing a hard drive

To install a hard drive, reverse the removal procedure.

Installing a hard drive with an operating system

If your hard drive shipped with an operating system (image) installed, system recovery discs are not required for setup. Turn on the computer and allow the initial setup process to set up the operating system completely.

**IMPORTANT:** Do not turn off the computer during the initial setup process. Allow the setup process to complete to ensure that everything that is necessary to operate the computer is installed properly.
After the setup has been completed, reinstall any applications and restore any data that you backed up.

If you need further assistance, call 1-800-474-6836 (1 800-HP Invent).

Installing a hard drive without an operating system

NOTE: If your hard drive was shipped without an operating system installed, you will need to reinstall it using the system recovery discs. To install the operating system, refer to the instructions included with your system recovery discs or that are available from the support site (http://www.hp.com/go/contactHP).

IMPORTANT: Do not turn off the computer during the initial setup process. Allow the system recovery process to complete to ensure that everything that is necessary to operate the computer is installed properly.

The system recovery process takes approximately 3 hours to complete. When the system recovery is complete, the computer reboots and the Windows Setup screen displays. After the operating system has been installed, reinstall any applications and restore any data that you backed up.

If you need further assistance, call 1-800-474-6836 (1 800-HP Invent).

Memory module

WARNING! To reduce the risk of electric shock and damage to the equipment, unplug the power cord and remove all batteries before installing a memory module.

CAUTION: Electrostatic discharge (ESD) can damage electronic components. Before beginning any procedure, ensure that you are discharged of static electricity by touching a grounded metal object.

NOTE: To use a dual-channel configuration with a second memory module, be sure that both memory modules are identical.

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>4 GB (PC3, 12800, 1600 MHz)</td>
<td>641369-001</td>
</tr>
<tr>
<td>2 GB (PC3, 12800, 1600 MHz)</td>
<td>652972-001</td>
</tr>
</tbody>
</table>

Before removing a memory module, follow these steps:

CAUTION: To prevent information loss or an unresponsive system, shut down the computer before adding or replacing memory modules. Do not remove a memory module while the computer is on, in the Sleep state, or in Hibernation.

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.
2. Disconnect all external devices connected to the computer.
3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then unplugging the AC adapter from the computer.
4. Remove the battery (see Battery on page 31).
5. Remove the service door (see Service door on page 32).
To add or replace a memory module:

1. Spread the retention clips (1) on each side of the memory module slot to release the memory module. (The memory module tilts up.)

2. Remove the memory module (2) by pulling it away from the slot at an angle.

⚠️ **CAUTION:** To prevent damage to the memory module, hold the memory module by the edges only. Do not touch the components on the memory module.

3. Align the notched edge (1) of the memory module with the tab in the memory module slot.

4. With the memory module at a 45-degree angle from the surface of the memory module compartment, press the module into the memory module slot (2) until it is seated.

⚠️ **CAUTION:** To protect a memory module after removal, place it in an electrostatic-safe container.
5. Gently press the memory module (3) down, applying pressure to both the left and right edges of the module, until the retention clips snap into place.
WLAN module

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Atheros 9485GN 802.11b/g/n 1x1 WiFi Adapter and 3012 Bluetooth 4.0 Combo Adapter (select models only)</td>
<td>655795-001</td>
</tr>
<tr>
<td>Atheros HB125 802.11b/g/n 1x1 WiFi Adapter (select models only)</td>
<td>675794-001</td>
</tr>
<tr>
<td>Broadcom 4313GN 802.11b/g/n 1x1 WiFi and 2070 Bluetooth 3.0+HS combination adapter (select models only)</td>
<td>600370-001</td>
</tr>
<tr>
<td>Broadcom 4313GN 802.11b/g/n 1x1 WiFi Adapter and 20702 Bluetooth 4.0+HS Combo Adapter</td>
<td>657325-001</td>
</tr>
<tr>
<td>Intel Centrino Wireless-N 2230 802.11b/g/n 2×2 WiFi and Bluetooth Combo Adapter</td>
<td>670290-001</td>
</tr>
<tr>
<td>Ralink RT5390BC8 802.11b/g/n 1×1 WiFi and Bluetooth 3.0+HS Combo Adapter</td>
<td>656120-001</td>
</tr>
<tr>
<td>Ralink RT5390F 802.11b/g/n 1×1 WiFi Adapter</td>
<td>670691-001</td>
</tr>
</tbody>
</table>

⚠️ CAUTION: To prevent an unresponsive system, replace the wireless module only with a wireless module authorized for use in the computer by the governmental agency that regulates wireless devices in your country or region. If you replace the module and then receive a warning message, remove the module to restore device functionality, and then contact technical support.

Before removing the WLAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.
2. Disconnect all external devices connected to the computer.
3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then unplugging the AC adapter from the computer.
4. Remove the battery (see Battery on page 31).
5. Remove the service door (see Service door on page 32).

Remove the WLAN module:

1. Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.

   ➡️ NOTE: The 1/black WLAN antenna cable is connected to the WLAN module 1/Main terminal. The 2/gray WLAN antenna cable is connected to the WLAN module 2/Aux terminal.

2. Remove the Phillips M2.5×2.5 screw (2) that secures the WLAN module to the system board. (The WLAN module tilts up.)
3. Remove the WLAN module by pulling the module away from the slot at an angle (3).

NOTE: The WLAN module is designed with a notch to prevent incorrect installation into the WLAN module socket.

Reverse this procedure to install the WLAN module.
**NOTE:** The keyboard spare part kit includes a keyboard cable.

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Black keyboard</strong></td>
<td></td>
</tr>
<tr>
<td>For use in Brazil</td>
<td>680555-201</td>
</tr>
<tr>
<td>For use in Canada</td>
<td>680555-DB1</td>
</tr>
<tr>
<td>For use in India</td>
<td>680555-D61</td>
</tr>
<tr>
<td>For use in Japan</td>
<td>680555-291</td>
</tr>
<tr>
<td>For use in Latin America</td>
<td>680555-161</td>
</tr>
<tr>
<td>For use in South Korea</td>
<td>680555-AD1</td>
</tr>
<tr>
<td>For use in Taiwan</td>
<td>680555-AB1</td>
</tr>
<tr>
<td>For use in Thailand</td>
<td>680555-281</td>
</tr>
<tr>
<td>For use in the United States</td>
<td>680555-001</td>
</tr>
<tr>
<td><strong>White keyboard</strong></td>
<td></td>
</tr>
<tr>
<td>For use in Brazil</td>
<td>684479-201</td>
</tr>
<tr>
<td>For use in Latin America</td>
<td>684479-161</td>
</tr>
</tbody>
</table>

Before removing the keyboard, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.
2. Disconnect all external devices connected to the computer.
3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then unplugging the AC adapter from the computer.
4. Remove the battery (see [Battery on page 31](#)).
5. Remove the service door (see [Service door on page 32](#)).
6. Remove the optical drive (see [Optical drive on page 33](#)).
7. Remove the hard drive (see [Hard drive on page 36](#)).
Remove the keyboard:

1. Remove the Phillips M2.5×6.5 screw that secures the keyboard to the computer.

2. Turn the computer right-side up with the front toward you and open the display.

3. Stand the computer on its left side.

4. Insert a finger or thin tool into the optical drive bay, and then press on the back of the keyboard until the keyboard disengages from the computer.

   **NOTE:** The keyboard icon in the optical drive bay indicates the point to apply pressure.

5. Turn the computer right-side up with the front toward you.
6. Lift the rear edge (1) of the keyboard, and then move the keyboard (2) toward the display panel.

7. Tilt the keyboard forward (1) onto the palm rest. Release the zero insertion force (ZIF) connector (2) to which the keyboard cable is attached, and then disconnect the keyboard cable (3) from the system board.

8. Remove the keyboard.
   Reverse this procedure to install the keyboard.
Top cover

NOTE: The top cover spare part kit includes the TouchPad.

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ruby Red</td>
<td>680574-001</td>
</tr>
<tr>
<td>Sparkling Black</td>
<td>680576-001</td>
</tr>
<tr>
<td>Winter Blue</td>
<td>680575-001</td>
</tr>
</tbody>
</table>

Before removing the top cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.
2. Disconnect all external devices connected to the computer.
3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then unplugging the AC adapter from the computer.
4. Remove the battery (see Battery on page 31).
5. Remove the service door (see Service door on page 32).
6. Remove the optical drive (see Optical drive on page 33).
7. Remove the hard drive (see Hard drive on page 36).
8. Remove the keyboard (see Keyboard on page 43).

When replacing the top cover, be sure that the following components are removed from the defective top cover and installed on the replacement top cover:

- Power button board and cable (see Power button board on page 50).
- TouchPad button board and cable (see TouchPad button board on page 51).
- TouchPad LED board and cable (see TouchPad LED board on page 52).
- Speakers and cable (see Speakers on page 49).
Remove the top cover:

1. Disconnect these cables from the system board:
   (1) Power button board ZIF cable
   (2) Speaker cable
   (3) TouchPad button board ZIF cable

2. Remove the following screws under the keyboard:
   (1) Three Phillips M2.5 x 3.0
   (2) Three Phillips M2.5 x 6.5

3. Close the computer.

4. Turn the computer upside down, with the front toward you.
5. Remove the following screws that secure the top cover to the computer:
   (1) Two Phillips M2.5 x 7.5
   (2) Five Phillips M2.5 x 6.5

6. Turn the computer right-side up, with the front toward you.
7. Open the computer.
8. Lift the front edge of the top cover (1) until the left and right sides disengage from the base enclosure.
9. Remove the top cover (2).

Reverse this procedure to install the top cover.
Speakers

**Speakers**

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Speaker Kit</strong> <em>(includes left and right speakers and cable)</em></td>
<td>680567-001</td>
</tr>
</tbody>
</table>

Before removing the speakers, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.
2. Disconnect all external devices connected to the computer.
3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then unplugging the AC adapter from the computer.
4. Remove the battery (see **Battery on page 31**).
5. Remove the service door (see **Service door on page 32**).
6. Remove the optical drive (see **Optical drive on page 33**).
7. Remove the hard drive (see **Hard drive on page 36**).
8. Remove the keyboard (see **Keyboard on page 43**).
9. Remove the top cover (see **Top cover on page 46**).

Remove the speakers:

1. Remove the Phillips M2.5 x 4 screw *(1)* from the left speaker and the Phillips M2.5 x 3 screw *(1)* from the right speaker.
2. Release the speaker cable from the clips built into the top cover *(2)*.
3. Lift the speakers from the top cover.

Reverse this procedure to install the speakers.
Power button board

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power button board (includes cable)</td>
<td>680560-001</td>
</tr>
</tbody>
</table>

Before removing the power button board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.
2. Disconnect all external devices connected to the computer.
3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then unplugging the AC adapter from the computer.
4. Remove the battery (see Battery on page 31).
5. Remove the service door (see Service door on page 32).
6. Remove the optical drive (see Optical drive on page 33).
7. Remove the hard drive (see Hard drive on page 36).
8. Remove the keyboard (see Keyboard on page 43).
9. Remove the top cover (see Top cover on page 46).
10. Remove the speakers (see Speakers on page 49).

Remove the power button board:

1. Turn the top cover upside down, with the front toward you.
2. Remove the Phillips M2.5 × 2.5 screw (1) that secures the power button board to the top cover.
3. Remove the power button board and cable (2).

Reverse this procedure to install the power button board.
# TouchPad button board

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>TouchPad button board (includes cable)</td>
<td>680559-001</td>
</tr>
</tbody>
</table>

Before removing the TouchPad button board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.
2. Disconnect all external devices connected to the computer.
3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then unplugging the AC adapter from the computer.
4. Remove the battery (see [Battery on page 31](#)).
5. Remove the service door (see [Service door on page 32](#)).
6. Remove the optical drive (see [Optical drive on page 33](#)).
7. Remove the hard drive (see [Hard drive on page 36](#)).
8. Remove the keyboard (see [Keyboard on page 43](#)).
9. Remove the top cover (see [Top cover on page 46](#)).

Remove the TouchPad button board and cable:

1. Turn the top cover upside down, with the front toward you.
2. Release the ZIF connector to which the TouchPad button board cable is connected, and then disconnect the TouchPad button board cable (1) from the back of the TouchPad.
3. Remove the Phillips M2.5 x 2.5 screw (2) that secures the TouchPad button board cable to the top cover.
4. Lift the front edge of the TouchPad button board (3) until it is released from the clips built into the top cover.
5. Lift the TouchPad button board (4) slightly to perform the next step.

6. Carefully invert the TouchPad button board (1).

7. Release the ZIF connector to which the TouchPad LED board cable is connected, and then disconnect the TouchPad LED board cable (2) from the TouchPad button board.

8. Lift the TouchPad button board away from the top cover (3).

Reverse this procedure to install the TouchPad button board and cable.

**TouchPad LED board**

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>TouchPad LED board (includes cable)</td>
<td>683848-001</td>
</tr>
</tbody>
</table>
Before removing the TouchPad LED board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.
2. Disconnect all external devices connected to the computer.
3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then unplugging the AC adapter from the computer.
4. Remove the battery (see Battery on page 31).
5. Remove the service door (see Service door on page 32).
6. Remove the optical drive (see Optical drive on page 33).
7. Remove the hard drive (see Hard drive on page 36).
8. Remove the keyboard (see Keyboard on page 43).
9. Remove the top cover (see Top cover on page 46).
10. Remove the TouchPad button board (see TouchPad button board on page 51).

Remove the TouchPad LED board and cable:

1. Turn the top cover upside down, with the front toward you.
2. Apply slight pressure to the retaining clips (1) of the top cover.
3. Lift the TouchPad LED board on the right front corner (2) up and away from the top cover.
4. Remove the TouchPad LED board and cable.

Reverse this procedure to install the TouchPad LED board and cable.
Display assembly

NOTE: The display assembly spare part kit includes webcam, two microphones, and wireless antenna transceivers and cables.

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>35.6 cm (14.0 in), HD, LED, BrightView display assembly</td>
<td></td>
</tr>
<tr>
<td>● Ruby Red</td>
<td>683845-001</td>
</tr>
<tr>
<td>● Sparkling Black</td>
<td>683847–001</td>
</tr>
<tr>
<td>● Winter Blue</td>
<td>683846-001</td>
</tr>
<tr>
<td>Display Screw Kit</td>
<td>680565-001</td>
</tr>
</tbody>
</table>

Before removing the display assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.
2. Disconnect all external devices connected to the computer.
3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then unplugging the AC adapter from the computer.
4. Remove the battery (see Battery on page 31).
5. Remove the service door (see Service door on page 32).
6. Remove the optical drive (see Optical drive on page 33).
7. Remove the hard drive (see Hard drive on page 36).
8. Remove the keyboard (see Keyboard on page 43).
9. Remove the top cover (see Top cover on page 46).

Remove the display assembly:

1. Disconnect the display panel cable (1) from the system board.
2. Release the wireless antenna cables (2) from the clips and the opening in the base enclosure.

**NOTE:** It may be necessary to release the USB board ZIF cable to remove the wireless antenna cables.

**CAUTION:** Support the display assembly when removing the following screws. Failure to support the display assembly can result in damage to the display assembly and other computer components.

3. Remove the four Phillips M2.5 × 6.5 screws (1) that secure the display assembly to the computer.

4. Remove the display assembly by lifting straight up (2).
5. If it is necessary to replace the display bezel or any of the display assembly subcomponents:
   a. Remove the plastic screw covers (1) and the two Phillips M2.5 × 3.5 screws (2) that secure the display bezel to the display assembly.
   b. Flex the inside edges of the top edge (1), the left and right sides (2), and the bottom edge (3) of the display bezel until the bezel disengages from the display enclosure.
   c. Remove the display bezel (4). The display bezel is available using spare part number 680545-001.

6. If it is necessary to replace the webcam/microphone module:
   a. Detach and release the webcam/microphone module (1) as far as the webcam/microphone module cable allows. (The webcam/microphone module is attached to the display enclosure with double-sided tape.)
b. Disconnect the webcam/microphone cable (2) from the webcam/microphone module.

c. Remove the webcam/microphone module. The webcam/microphone module is available using spare part number 680577-001.

7. If it is necessary to replace the hinge covers, to remove the display cable, or to remove the antenna cables:

a. The hinge covers are held in place by the same screws as the previously removed bezel.

b. Using a small tool to pry, remove the hinge covers. The hinge covers are available using spare part number 680553-001.
8. If it is necessary to replace the display panel:
   
a. Remove the four bottom Phillips M2.5 × 3.5 screws and the two top Phillips M2.5 × 2.5 screws that secure the display panel to the display enclosure.

b. Lift the top edge of the display enclosure, (1) and then swing it up and forward until it is perpendicular to the display panel.
c. Release the adhesive strip (2) that secures the display panel cable to the display panel, and then disconnect the display panel cable (3) from the display panel.

d. Remove the display panel. The display panel cable is available using spare part number 680547-001.

9. If it is necessary to replace the display hinges:

   a. Remove the four Phillips M2.0 × 3.0 screws (1) that secure the display hinges to the display panel.
b. Remove the display hinges (2). The display hinges include the display hinges and brackets and are available using spare part number 680554-001.

10. If it is necessary to replace the display panel cable:

   a. Release the tabs (1) built into the display enclosure shielding that secure the display panel cable to the display enclosure.

   b. Release the display panel cable from the clips (2) built into the display enclosure.

   c. Remove the display panel cable. The display panel cable includes the webcam/microphone module cable and is available in the Display Panel Cable Kit, spare part number 680547-001.
11. If it is necessary to replace the wireless antenna cables and transceivers:
   a. Release the wireless antenna cables from the clips (1) built into the display enclosure.
   b. Release the wireless antenna transceivers (2) from the display enclosure. (The wireless antenna transceivers are attached to the display enclosure with double-sided tape.)
   c. Remove the wireless antenna cables and transceivers. The wireless antenna cables and transceivers are available in the Antenna Kit, spare part number 680539-001.

The display panel is available using spare part number 680562-001.

Reverse this procedure to reassemble and install the display assembly.

Optical drive cable

**NOTE:** The optical drive cable is included in the Cable Kit, spare part number 680546-001. The optical drive cable includes the optical drive connector.

Before removing the optical drive cable, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.
2. Disconnect all external devices connected to the computer.
3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then unplugging the AC adapter from the computer.
4. Remove the battery (see Battery on page 31).
5. Remove the service door (see Service door on page 32).
6. Remove the optical drive (see Optical drive on page 33).
7. Remove the hard drive (see Hard drive on page 36).
8. Remove the keyboard (see Keyboard on page 43).
9. Remove the top cover (see Top cover on page 46).
Remove the optical drive cable:

1. Disconnect the optical drive cable (1) from the system board.
2. Release the optical drive cable (2) from the clips built into the base enclosure.
3. Release the optical drive connector from the base enclosure by prying the clips (3) that secure the optical drive connector to the base enclosure.
4. Remove the optical drive cable from the base enclosure (4).

Reverse this procedure to install the optical drive cable.
USB board

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>USB board (includes cable)</td>
<td>680558-001</td>
</tr>
</tbody>
</table>

Before removing the USB board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.
2. Disconnect all external devices connected to the computer.
3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then unplugging the AC adapter from the computer.
4. Remove the battery (see Battery on page 31).
5. Remove the service door (see Service door on page 32).
6. Remove the optical drive (see Optical drive on page 33).
7. Remove the hard drive (see Hard drive on page 36).
8. Remove the keyboard (see Keyboard on page 43).
9. Remove the top cover (see Top cover on page 46).

Remove the USB board:

1. If not released already, release the ZIF connector (1) to which the USB board cable is connected, and then disconnect the USB board cable from the system board.
2. Pry the clip (2) that secures the USB board to the base enclosure.
3. Remove the USB board and cable by lifting straight up (3).

Reverse this procedure to install the USB board.
Power connector cable

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power connector cable</td>
<td>680548-001</td>
</tr>
</tbody>
</table>

Before removing the power connector cable, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.
2. Disconnect all external devices connected to the computer.
3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then unplugging the AC adapter from the computer.
4. Remove the battery (see Battery on page 31).
5. Remove the service door (see Service door on page 32).
6. Remove the optical drive (see Optical drive on page 33).
7. Remove the hard drive (see Hard drive on page 36).
8. Remove the keyboard (see Keyboard on page 43).
9. Remove the top cover (see Top cover on page 46).

Remove the power connector cable:

1. Disconnect the power connector cable (1) from the system board.
2. Remove the power connector from the base enclosure (2).

Reverse this procedure to install the power connector cable.
System board

NOTE: The system board thermal pad kit, part number 680571-001, includes replacement thermal material.

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>For use only with computer models equipped with UMA video memory</td>
<td>680568-001</td>
</tr>
<tr>
<td>For use only with computer models equipped with 2048 MB of dedicated discrete video memory</td>
<td>680570-001</td>
</tr>
<tr>
<td>For use only with computer models equipped with 1024 MB of dedicated discrete video memory</td>
<td>680569-001</td>
</tr>
</tbody>
</table>

Before removing the system board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.
2. Disconnect all external devices connected to the computer.
3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then unplugging the AC adapter from the computer.
4. Remove the battery (see Battery on page 31).
5. Remove the service door (see Service door on page 32).
6. Remove the optical drive (see Optical drive on page 33).
7. Remove the hard drive (see Hard drive on page 36).
8. Remove the keyboard (see Keyboard on page 43).
9. Remove the top cover (see Top cover on page 46).

When replacing the system board, be sure that the following components are removed from the defective system board and installed on the replacement system board:

- Memory module (see Memory module on page 38)
- RTC battery (see RTC battery on page 67)
- Fan and heat sink (see Fan and heat sink on page 68).
- PCH heat sink (see PCH heat sink on page 71)
- Processor (see Processor on page 72)
Remove the system board:

1. Disconnect the following cables from the system board:
   (1) Display panel cable
   (2) optical drive cable
   (3) USB board cable
   (4) Power connector cable

2. Remove the Phillips M2.5 × 4.5 screw (1) that secures the system board to the base enclosure.

3. Lift the right side of the system board (2) until it rests at an angle.

4. Remove the system board (3) by sliding it up and to the right at an angle.

Reverse this procedure to install the system board.
RTC battery

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>RTC battery (includes cable and double-sided tape)</td>
<td>637193-001</td>
</tr>
</tbody>
</table>

Before removing the RTC battery, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.
2. Disconnect all external devices connected to the computer.
3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then unplugging the AC adapter from the computer.
4. Remove the battery (see Battery on page 31).
5. Remove the service door (see Service door on page 32).
6. Remove the optical drive (see Optical drive on page 33).
7. Remove the hard drive (see Hard drive on page 36).
8. Remove the keyboard (see Keyboard on page 43).
9. Remove the top cover (see Top cover on page 46).
10. Remove the system board (see System board on page 65).

Remove the RTC battery:

1. Turn the system board upside down, with the front toward you.
2. Disconnect the RTC battery cable (1) from the system board.
3. Remove the RTC battery (2) from the system board. (The RTC battery is attached to the system board with double-sided tape.)

Reverse this procedure to install the RTC battery.
Fan and heat sink

**NOTE:** The fan and heat sink spare part kits include replacement thermal material.

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fan</td>
<td>680551-001</td>
</tr>
<tr>
<td>Heat sink for use only with computer models equipped with UMA video memory</td>
<td>680549-001</td>
</tr>
<tr>
<td>Heat sink for use only with computer models equipped with discrete video memory</td>
<td>680550-001</td>
</tr>
</tbody>
</table>

**NOTE:** To properly ventilate the computer, allow at least 7.6 cm (3 in) of clearance on the left side of the computer. The computer uses an electric fan for ventilation. The fan is controlled by a temperature sensor and is designed to turn on automatically when high temperature conditions exist. These conditions are affected by high external temperatures, system power consumption, power management/battery conservation configurations, battery fast charging, and software requirements. Exhaust air is displaced through the ventilation grill located on the left side of the computer.

Before removing the fan and heat sink, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.
2. Disconnect all external devices connected to the computer.
3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then unplugging the AC adapter from the computer.
4. Remove the battery (see Battery on page 31).
5. Remove the service door (see Service door on page 32).
6. Remove the optical drive (see Optical drive on page 33).
7. Remove the hard drive (see Hard drive on page 36).
8. Remove the keyboard (see Keyboard on page 43).
9. Remove the top cover (see Top cover on page 46).
10. Remove the system board (see System board on page 65).

Remove the fan and heat sink:

1. Turn the system board upside down, with the front toward you.
2. Disconnect the fan cable (1) from the system board.
3. **CAUTION:** To prevent damage to heat sinks and/or processors, loosen/tighten captive screws in sequence as numerically labeled.

**NOTE:** The heat sink and fan appearance and the number of screws may be different from the heat sink and fan pictured.

3. Loosen the four captive screws (2) and the three captive screws (3) that secure the heat sink to the system board.

**NOTE:** Due to the adhesive quality of the thermal material located between the heat sink and system board components, it may be necessary to move the heat sink from side to side to detach it.
4. Remove the fan and heat sink (4).

**NOTE:** The thermal material must be thoroughly cleaned from the surfaces of the heat sink and the system board components each time the heat sink is removed. Replacement thermal material is included with the base enclosure, heat sink, processor, and system board spare part kits.

- Thermal paste is used on the processor (1) and the heat sink section (2) that services it
- A thermal pad is used on the graphics subsystem chip (3) and the heat sink section (4) that services it (only on computer models equipped with a graphics subsystem with discrete memory)

1. If it is necessary to replace the fan, turn the fan and heat sink upside down with the fan toward you.

2. Remove the two Phillips M1.5 × 2.5 screws (1) that secure the fan to the heat sink.
3. Disengage the two clips that secure the fan to the heat sink and remove the heat sink (2) from the fan.

Reverse this procedure to reassemble and install the fan and heat sink.
Before removing the PCH heat sink, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.
2. Disconnect all external devices connected to the computer.
3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then unplugging the AC adapter from the computer.
4. Remove the battery (see Battery on page 31).
5. Remove the service door (see Service door on page 32).
6. Remove the optical drive (see Optical drive on page 33).
7. Remove the hard drive (see Hard drive on page 36).
8. Remove the keyboard (see Keyboard on page 43).
9. Remove the top cover (see Top cover on page 46).
10. Remove the system board (see System board on page 65).

Remove the PCH heat sink:

1. Remove the two Phillips M2.0 x 3.0 screws (1) that secure the PCH heat sink to the system board.
2. Remove the PCH heat sink by lifting straight up (2).

**NOTE:** Due to the adhesive quality of the thermal material located between the heat sink and system board components, it may be necessary to move the heat sink from side to side to detach it.

Reverse this procedure to install the PCH heat sink.

**Processor**

**NOTE:** The processor spare part kit includes replacement thermal material.

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Intel Core i5-2450M processor</strong> (2.50 GHz, SC turbo up to 3.10 GHz, 1333 MHz/3.0 MB L3 cache, dual core, 35 W)</td>
<td>676359-001</td>
</tr>
<tr>
<td><strong>Intel Core i3-2350M processor</strong> (2.30 GHz, 1333 MHz/3.0 MB L3 cache, dual core, 35 W)</td>
<td>653340-001</td>
</tr>
<tr>
<td><strong>Intel Core i3-2330M processor</strong> (2.20 GHz, 1333 MHz/3.0 MB L3 cache, dual core, 35 W)</td>
<td>653339-001</td>
</tr>
<tr>
<td><strong>Intel Pentium B960 processor</strong> (2.20 GHz, 1333 MHz/2.0 MB L3 cache, dual core, 35 W)</td>
<td>664662-001</td>
</tr>
</tbody>
</table>

Before removing the processor, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.
2. Disconnect all external devices connected to the computer.
3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then unplugging the AC adapter from the computer.
4. Remove the battery (see Battery on page 31).
5. Remove the service door (see Service door on page 32).
6. Remove the optical drive (see Optical drive on page 33).
7. Remove the hard drive (see Hard drive on page 36).
8. Remove the keyboard (see Keyboard on page 43).
9. Remove the top cover (see Top cover on page 46).
10. Remove the system board (see System board on page 65).
11. Remove the heat sink (see Fan and heat sink on page 68).

Remove the processor:

1. Use a flat-bladed screw driver (1) to turn the processor locking screw one-half turn counterclockwise, until you hear a click.

2. Lift the processor (2) straight up, and remove it.

**NOTE:** The gold triangle on the processor (3) must be aligned with the triangle icon embossed on the processor socket when you install the processor.

Reverse this procedure to install the processor.
5 Setup Utility (BIOS) and System Diagnostics

Using Setup Utility

Setup Utility, or Basic Input/Output System (BIOS), controls communication between all the input and output devices on the system (such as disk drives, display, keyboard, mouse, and printer). Setup Utility includes settings for the types of peripherals installed, the startup sequence of the computer, and the amount of system and extended memory.

**NOTE:** Use extreme care when making changes in Setup Utility. Errors can prevent the computer from operating properly.

Starting Setup Utility

**NOTE:** An external keyboard or mouse connected to a USB port can be used with Setup Utility only if USB legacy support is enabled.

To start Setup Utility, follow these steps:

1. Turn on or restart the computer, and then press **esc** while the "Press the ESC key for Startup Menu" message is displayed at the bottom of the screen.
2. Press **f10** to enter Setup Utility.

Changing the language of Setup Utility

2. Use the arrow keys to select **System Configuration > Language**, and then press **enter**.
3. Use the arrow keys to select a language, and then press **enter**.
4. When a confirmation prompt with your language selected is displayed, press **enter**.
5. To save your change and exit Setup Utility, use the arrow keys to select **Exit > Exit Saving Changes**, and then press **enter**.

Your change takes effect immediately.
Navigating and selecting in Setup Utility

To navigate and select in Setup Utility, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the screen.
   - To select a menu or a menu item, use the tab key and the keyboard arrow keys and then press enter, or use a pointing device to click the item.
   - To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the screen, or use the up arrow key or the down arrow key.
   - To close open dialog boxes and return to the main Setup Utility screen, press esc, and then follow the on-screen instructions.

   \[\textbf{NOTE:}\] You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the keyboard to navigate and make selections in Setup Utility.

2. Press f10 to enter Setup Utility.

To exit Setup Utility menus, choose one of the following methods:

- To exit Setup Utility menus without saving your changes, click the Exit icon in the lower-left corner of the screen, and then follow the on-screen instructions.
  - or –
  Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press enter.

- To save your changes and exit Setup Utility menus, click the Save icon in the lower-left corner of the screen, and then follow the on-screen instructions.
  - or –
  Use the tab key and the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

Displaying system information


2. Select the Main menu. System information such as the system time and date, and identification information about the computer is displayed.

3. To exit Setup Utility without changing any settings, use the arrow keys to select Exit > Exit Discarding Changes, and then press enter.
Restoring factory settings in Setup Utility

**NOTE:** Restoring defaults will not change the hard drive mode.

To return all settings in Setup Utility to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press `esc` while the "Press the ESC key for Startup Menu" message is displayed at the bottom of the screen.

2. Press `f10` to enter Setup Utility.

3. Use a pointing device or the arrow keys to select **File > Restore Defaults**.

4. Follow the on-screen instructions.

5. To save your changes and exit, click the **Save** icon in the lower-left corner of the screen, and then follow the on-screen instructions.

   – or –

   Use the arrow keys to select **File > Save Changes and Exit**, and then press `enter`.

Your changes go into effect when the computer restarts.

**NOTE:** Your password settings and security settings are not changed when you restore the factory settings.

Exiting Setup Utility

- To exit Setup Utility and save your changes from the current session:

  If the Setup Utility menus are not visible, press `esc` to return to the menu display. Then use the arrow keys to select **Exit > Exit Saving Changes**, and then press `enter`.

- To exit Setup Utility without saving your changes from the current session:

  If the Setup Utility menus are not visible, press `esc` to return to the menu display. Then use the arrow keys to select **Exit > Exit Discarding Changes**, and then press `enter`.

Updating the BIOS

Updated versions of the BIOS may be available on the HP Web site.

Most BIOS updates on the HP Web site are packaged in compressed files called **SoftPaqs**.

Some download packages contain a file named Readme.txt, which contains information regarding installing and troubleshooting the file.
Determining the BIOS version

To determine whether available BIOS updates contain later BIOS versions than those currently installed on the computer, you need to know the version of the system BIOS currently installed.

BIOS version information (also known as ROM date and System BIOS) can be displayed by pressing fn+esc (if you are already in Windows) or by using Setup Utility.

2. Use a pointing device or the arrow keys to select File > System Information.
3. To exit Setup Utility without saving your changes, click the Exit icon in the lower-left corner of the screen, and then follow the on-screen instructions.
   – or –
   Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press enter.

Downloading a BIOS update

⚠ CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation, download and install a BIOS update only when the computer is connected to reliable external power using the AC adapter. Do not download or install a BIOS update while the computer is running on battery power, docked in an optional docking device, or connected to an optional power source. During the download and installation, follow these instructions:

Do not disconnect power from the computer by unplugging the power cord from the AC outlet.
Do not shut down the computer or initiate Sleep or Hibernation.
Do not insert, remove, connect, or disconnect any device, cable, or cord.

1. Select Start > Help and Support > Maintain.
2. Follow the on-screen instructions to identify your computer and access the BIOS update you want to download.
3. At the download area, follow these steps:
   a. Identify the BIOS update that is later than the BIOS version currently installed on your computer. Make a note of the date, name, or other identifier. You may need this information to locate the update later, after it has been downloaded to your hard drive.
   b. Follow the on-screen instructions to download your selection to the hard drive. Make a note of the path to the location on your hard drive where the BIOS update is downloaded. You will need to access this path when you are ready to install the update.

   NOTE: If you connect your computer to a network, consult the network administrator before installing any software updates, especially system BIOS updates.

BIOS installation procedures vary. Follow any instructions that are displayed on the screen after the download is complete. If no instructions are displayed, follow these steps:

1. Open Windows Explorer by selecting Start > Computer.
2. Double-click your hard drive designation. The hard drive designation is typically Local Disk (C:).
3. Using the hard drive path you recorded earlier, open the folder on your hard drive that contains the update.
4. Double-click the file that has an .exe extension (for example, filename.exe).
   The BIOS installation begins.

5. Complete the installation by following the on-screen instructions.

   **NOTE:** After a message on the screen reports a successful installation, you can delete the downloaded file from your hard drive.

---

**Using System Diagnostics**

System Diagnostics allows you to run diagnostic tests to determine if the computer hardware is functioning properly. The following diagnostic tests are available in System Diagnostics:

- **Start-up test**—This test analyzes the main computer components that are required to start the computer.
- **Run-in test**—This test repeats the start-up test and checks for intermittent problems that the start-up test does not detect.
- **Hard disk test**—This test analyzes the physical condition of the hard drive, and then checks all data in every sector of the hard drive. If the test detects a damaged sector, it attempts to move the data to a good sector.
- **Memory test**—This test analyzes the physical condition of the memory modules. If it reports an error, replace the memory modules immediately.
- **Battery test**—This test analyzes the condition of the battery. If the battery fails the test, contact HP support to report the issue and purchase a replacement battery.

You can also view system information and error logs in the System Diagnostics window.

To start System Diagnostics:

1. Turn on or restart the computer. While the “Press the ESC key for Startup Menu” message is displayed in the lower-left corner of the screen, press **esc**. When the Startup Menu is displayed, press **f2**.

2. Click the diagnostic test you want to run, and then follow the on-screen instructions.

   **NOTE:** If you need to stop a diagnostics test while it is running, press **esc**.
## Specifications

### Computer specifications

<table>
<thead>
<tr>
<th>Metric</th>
<th>U.S.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Dimensions:</strong></td>
<td></td>
</tr>
<tr>
<td>Width</td>
<td>34.7 cm</td>
</tr>
<tr>
<td>Depth</td>
<td>23.1 cm</td>
</tr>
<tr>
<td>Height (front to back)</td>
<td>3.0 cm to 3.6 cm</td>
</tr>
<tr>
<td><strong>Weight:</strong></td>
<td>2.20 kg</td>
</tr>
<tr>
<td><strong>Input power</strong></td>
<td></td>
</tr>
<tr>
<td>Operating voltage and current</td>
<td>18.5 V dc @ 3.5 A or 19.5 V dc @ 3.33 A – 65 W</td>
</tr>
<tr>
<td><strong>Temperature</strong></td>
<td></td>
</tr>
<tr>
<td>Operating (writing to optical disc)</td>
<td>5°C to 35°C</td>
</tr>
<tr>
<td>Nonoperating</td>
<td>-20°C to 60°C</td>
</tr>
<tr>
<td><strong>Relative humidity</strong></td>
<td></td>
</tr>
<tr>
<td>Operating</td>
<td>10% to 90%</td>
</tr>
<tr>
<td>Nonoperating</td>
<td>5% to 90%</td>
</tr>
<tr>
<td><strong>Maximum altitude</strong> (unpressurized)</td>
<td></td>
</tr>
<tr>
<td>Operating (14.7 to 10.1 psia)</td>
<td>-15 m to 3,048 m</td>
</tr>
<tr>
<td>Nonoperating (14.7 to 4.4 psia)</td>
<td>-15 m to 12,192 m</td>
</tr>
<tr>
<td><strong>Shock</strong></td>
<td></td>
</tr>
<tr>
<td>Operating</td>
<td>125 g, 2 ms, half-sine</td>
</tr>
<tr>
<td>Nonoperating</td>
<td>200 g, 2 ms, half-sine</td>
</tr>
<tr>
<td><strong>Random vibration</strong></td>
<td></td>
</tr>
<tr>
<td>Operating</td>
<td>0.75 g zero-to-peak, 10 Hz to 500 Hz, 0.25 oct/min sweep rate</td>
</tr>
<tr>
<td>Nonoperating</td>
<td>1.50 g zero-to-peak, 10 Hz to 500 Hz, 0.5 oct/min sweep rate</td>
</tr>
</tbody>
</table>

**NOTE:** Applicable product safety standards specify thermal limits for plastic surfaces. The computer operates well within this range of temperatures.
### 35.6 cm (14.0 in), display specifications

<table>
<thead>
<tr>
<th></th>
<th>Metric</th>
<th>U.S.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Dimensions</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Width</td>
<td>31.2 cm</td>
<td>12.28 in</td>
</tr>
<tr>
<td>Height</td>
<td>17.6 cm</td>
<td>6.93 in</td>
</tr>
<tr>
<td>Diagonal</td>
<td>35.7 cm</td>
<td>14.05 in</td>
</tr>
<tr>
<td><strong>Number of colors</strong></td>
<td>Up to 16.8 million</td>
<td></td>
</tr>
<tr>
<td><strong>Contrast ratio</strong></td>
<td>200:1 (typical)</td>
<td></td>
</tr>
<tr>
<td><strong>Brightness</strong></td>
<td>200 cd/m² (nits) (typical)</td>
<td></td>
</tr>
<tr>
<td><strong>Backlight</strong></td>
<td>LED</td>
<td></td>
</tr>
<tr>
<td><strong>Character display</strong></td>
<td>80 × 25</td>
<td></td>
</tr>
<tr>
<td><strong>Total power consumption</strong></td>
<td>6.0 W</td>
<td></td>
</tr>
<tr>
<td><strong>Viewing angle</strong></td>
<td>+/-65 horizontal, +/-50° vertical (typical)</td>
<td></td>
</tr>
</tbody>
</table>

### Hard drive specifications

<table>
<thead>
<tr>
<th></th>
<th>1 TB*</th>
<th>750 GB*</th>
<th>640 GB*</th>
<th>500 GB*</th>
<th>320 GB*</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Dimensions</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Height</td>
<td>9.5 mm</td>
<td>9.5 mm</td>
<td>9.5 mm</td>
<td>9.5 mm</td>
<td>7.0 mm</td>
</tr>
<tr>
<td>Width</td>
<td>70 mm</td>
<td>70 mm</td>
<td>70 mm</td>
<td>70 mm</td>
<td>70 mm</td>
</tr>
<tr>
<td>Weight</td>
<td>107 g max</td>
<td>107 g max</td>
<td>107 g max</td>
<td>107 g max</td>
<td>107 g max</td>
</tr>
<tr>
<td><strong>Interface type</strong></td>
<td>SATA</td>
<td>SATA</td>
<td>SATA</td>
<td>SATA</td>
<td>SATA</td>
</tr>
<tr>
<td><strong>Transfer rate</strong></td>
<td>300 MB/sec</td>
<td>300 MB/sec</td>
<td>300 MB/sec</td>
<td>300 MB/sec</td>
<td>300 MB/sec</td>
</tr>
<tr>
<td><strong>Security</strong></td>
<td>ATA security</td>
<td>ATA security</td>
<td>ATA security</td>
<td>ATA security</td>
<td>ATA security</td>
</tr>
<tr>
<td><strong>Seek times</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Single track</td>
<td>1.5 ms</td>
<td>1.0 ms</td>
<td>1.0 ms</td>
<td>1.5 ms</td>
<td>2.0 ms</td>
</tr>
<tr>
<td>Average</td>
<td>11.0 ms</td>
<td>14.0 ms</td>
<td>14.0 ms</td>
<td>12.0 ms</td>
<td>12.0 ms</td>
</tr>
<tr>
<td>Maximum</td>
<td>22.0 ms</td>
<td>24.0 ms</td>
<td>22.0 ms</td>
<td>22.0 ms</td>
<td>22.0 ms</td>
</tr>
<tr>
<td>Logical blocks</td>
<td>1,953,525,168</td>
<td>1,465,128,359</td>
<td>1,250,242,867</td>
<td>976,752,240</td>
<td>625,121,433</td>
</tr>
<tr>
<td>Disk rotational speed</td>
<td>5400 rpm</td>
<td>7200 and 5400 rpm</td>
<td>5400 rpm</td>
<td>7200 and 5400 rpm</td>
<td>7200 and 5400 rpm</td>
</tr>
<tr>
<td><strong>Operating temperature</strong></td>
<td>5°C to 55°C (41°F to 131°F)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*Size refers to hard drive storage capacity. Actual accessible capacity is less. Actual drive specifications may differ slightly.

**NOTE:** Certain restrictions and exclusions apply. Contact support for details.
<table>
<thead>
<tr>
<th><strong>Applicable disc</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Random access time</strong></td>
<td></td>
</tr>
<tr>
<td><strong>DVD</strong></td>
<td>&lt; 230 ms</td>
</tr>
<tr>
<td><strong>CD</strong></td>
<td>&lt; 175 ms</td>
</tr>
<tr>
<td><strong>Cache buffer</strong></td>
<td>2 MB</td>
</tr>
<tr>
<td><strong>Data transfer rate</strong></td>
<td></td>
</tr>
<tr>
<td><strong>24X CD-ROM</strong></td>
<td>3,600 KB/sec</td>
</tr>
<tr>
<td><strong>8X DVD-ROM</strong></td>
<td>10,800 KB/sec</td>
</tr>
<tr>
<td><strong>24X CD-R</strong></td>
<td>3,600 KB/sec</td>
</tr>
<tr>
<td><strong>16X CD-RW</strong></td>
<td>2,400 KB/sec</td>
</tr>
<tr>
<td><strong>8X DVD+R</strong></td>
<td>10,800 KB/sec</td>
</tr>
<tr>
<td><strong>4X DVD+RW</strong></td>
<td>5,400 KB/sec</td>
</tr>
<tr>
<td><strong>8X DVD-R</strong></td>
<td>10,800 KB/sec</td>
</tr>
<tr>
<td><strong>4X DVD-RW</strong></td>
<td>5,400 KB/sec</td>
</tr>
<tr>
<td><strong>2.4X DVD+(9)</strong></td>
<td>2,700 KB/sec</td>
</tr>
<tr>
<td><strong>5X DVD-RAM</strong></td>
<td>6,750 KB/sec</td>
</tr>
<tr>
<td><strong>Transfer mode</strong></td>
<td>Multiword DMA Mode</td>
</tr>
</tbody>
</table>
### BD ROM DVD±R/RW Super Multi Double-Layer Drive specifications

<table>
<thead>
<tr>
<th>Applicable disc</th>
<th>Read</th>
<th>Write</th>
</tr>
</thead>
</table>
| Random access time | BD: < 230 ms  
DVD: < 180 ms  
CD: < 180 ms |                                                                                         |
| Cache buffer    | 4.5 MB                                                                                         |                                                                                         |
| Data transfer rate | 24X CD-ROM: 3,600 KB/sec  
8X DVD-ROM: 10,800 KB/sec  
4X BD: 18,000 KB/sec  
24X CD-R: 3,600 KB/sec  
16X CD-RW: 2,400 KB/sec  
8X DVD+R: 10,800 KB/sec  
4X DVD+RW: 5,400 KB/sec  
8X DVD-R: 10,800 KB/sec  
4X DVD-RW: 5,400 KB/sec  
2.4X DVD+R(9): 2,700 KB/sec  
5X DVD-RAM: 6,750 KB/sec  
1X BD-ROM: 4,500 KB/sec  
1X BD-R read: 4,500 KB/sec  
1X BD-RE read: 4,500 KB/sec | Multiword DMA Mode |
| Transfer mode    |                                                                                                 |                                                                                         |
7 Backing up, restoring, and recovering

Your computer includes tools provided by the operating system and HP to help you safeguard your information and retrieve it if ever needed.

Creating backups

1. Use HP Recovery Manager to create recovery media immediately after you set up the working computer.
2. As you add hardware and software programs, create system restore points.
3. As you add photos, video, music, and other personal files, create a backup of your system and personal information.

Creating recovery media to recover the original system

After you successfully set up the computer, you should create recovery discs or a recovery flash drive using HP Recovery Manager. You will need these recovery discs or recovery flash drive to perform a system recovery should the hard drive become corrupted. A system recovery reinstalls the original operating system, and then configures the settings for the default programs.

What you need to know

- Only one set of recovery media can be created. Handle these recovery tools carefully, and keep them in a safe place.
- HP Recovery Manager examines the computer and determines the required storage capacity for the flash drive or the number of blank DVD discs that will be required.
  Use DVD-R, DVD+R, DVD-R DL, DVD+R DL discs or a flash drive. Do not use rewriteable discs such as CD±RW, DVD±RW, double-layer DVD±RW, and BD-RE (rewritable Blu-ray) discs; they are not compatible with HP Recovery Manager software.
- If your computer does not include an integrated optical drive, you can use an optional external optical drive (purchased separately) to create recovery discs, or you can obtain recovery discs for your computer from the HP website. If you use an external optical drive, it must be connected directly to a USB port on the computer, not to a USB port on an external device, such as a USB hub.
- Be sure that the computer is connected to AC power before you begin creating the recovery media.
- The creation process can take up to an hour or more. Do not interrupt the creation process.
- Store the recovery media in a safe location, separate from the computer.
- If necessary, you can exit the program before you have finished creating the recovery media. The next time you open HP Recovery Manager, you will be prompted to continue the process.
Creating the recovery media

1. Select Start and type recovery in the search field. Select Recovery Manager from the list. Allow the action to continue, if prompted.
2. Click Recovery Media Creation.
3. Follow the on-screen instructions to continue.
To recover, see Recovering the original system using HP Recovery Manager on page 86

Creating system restore points

A system restore point is a snapshot of certain hard drive contents saved by Windows System Restore at a specific time. A restore point contains information such as registry settings that Windows uses. Restoring to a previous restore point allows you to reverse changes that have been made to the system since the restore point was created.

Restoring to an earlier system restore point does not affect data files saved or emails created since the last restore point, but it does affect software you may have installed.

For example, if you download a photo from a digital camera and then restore the computer to the state it was on the previous day, the photo remains on the computer.

However, if you install photo viewing software and then restore your computer to the state it was on the previous day, the software will be uninstalled, and you won't be able to use it.

What you need to know

● If you restore to a restore point and then change your mind, you can undo the restoration.
● You should create system restore points:
  ◦ Before you add or change software or hardware
  ◦ Periodically, whenever the computer is running normally
● System Restore also saves shadow copies of files that have been changed since the last restore point was created. For more information about using shadow copies to restore, see Help and Support.

Creating a system restore point

2. In the left pane, click System Protection.
3. Click the System Protection tab.
4. Click Create, and follow the on-screen instructions.
To restore, see Restoring to a previous system restore point on page 86.

Backing up system and personal information

Your computer stores information that is important to you, such as files, emails, and photos, and you will want to keep that information even if you download a virus or the system stops working properly. How completely you are able to recover your files depends on how recent your backup is. As you add new software and data files, you should create backups on a regular basis.
Tips for a successful backup

- Number backup discs before inserting them into the optical drive.
- Store personal files in the Documents, Music, Pictures, and Videos libraries, and back up these folders periodically.
- Save customized settings in a window, toolbar, or menu bar by taking a screen shot of your settings. The screen shot can be a time-saver if you have to re-enter your preferences.

To create a screen shot:
1. Display the screen you want to save.
2. Copy the screen image:
   - To copy only the active window, press `alt+prt sc`.
   - To copy the entire screen, press `prt sc`.
3. Open a word-processing document or graphics editing program, and then select Edit > Paste.
   The screen image is added to the document.
4. Save and print the document.

What you need to know

- You can back up your information to an optional external hard drive, a flash drive, a network drive, or discs.
- Connect the computer to AC power during backups.
- Allow enough time for the backup. Depending on files sizes, it may take more than an hour.
- Verify the amount of free space on your backup storage device before you back up.
- You should back up:
  - Before adding or changing software or hardware.
  - Before the computer is repaired or restored.
  - On a regular schedule to be sure you have recent copies of personal information.
  - After you add many files—for example, if you saved videos from a birthday party.
  - Before using antivirus software to remove a malicious program.
  - After adding information that is hard to replace, such as pictures, videos, music, project files, or data records.

Creating a backup using Windows Backup and Restore

Windows allows you to back up files using Windows Backup and Restore. You can select the level you want to back up, from individual folders to drives. The backups are compressed to save space.

To back up:
2. Follow the on-screen instructions to schedule and create a backup.

**NOTE:** Windows includes the User Account Control feature to improve the security of the computer. You may be prompted for your permission or password for tasks such as installing software, running utilities, or changing Windows settings. See Help and Support for more information.
Restore and recovery

Restoring to a previous system restore point

Sometimes installing a software program causes your computer or Windows to behave unpredictably. Usually uninstalling the software fixes the problems. If uninstalling does not fix the problems, you can restore the computer to a previous system restore point (created at an earlier date and time).

To restore to a previous system restore point, when the computer was running correctly:

1. Select **Start > Control Panel > System and Security > System**.
2. In the left pane, click **System Protection**.
3. Click the **System Protection** tab.
4. Click **System Restore**, and follow the on-screen instructions.

Restoring specific files

If files are accidentally deleted from the hard disk and they can no longer be restored from the Recycle Bin, or if files become corrupt, restoring specific files is useful. Restoring specific files is also useful if you ever choose to recover the original system using HP Recovery Manager. You can only restore specific files that you have backed up before.

Restoring specific files using Windows Backup and Restore

Windows allows you to restore files that were backed up using Windows Backup and Restore:

1. Select **Start > Control Panel > System and Security > Backup and Restore**.
2. Follow the on-screen instructions to restore your backup.

**NOTE:** Windows includes the User Account Control feature to improve the security of the computer. You may be prompted for your permission or password for tasks such as installing software, running utilities, or changing Windows settings. See Help and Support for more information.

Recovering the original system using HP Recovery Manager

HP Recovery Manager software allows you to repair or recover the computer to its original factory state.

What you need to know

- HP Recovery Manager recovers only software that was installed at the factory. For software not provided with this computer, you must either download the software from the manufacturer’s website or reinstall the software from the disc provided by the manufacturer.

- A system recovery should be used as a final attempt to correct computer issues. If you have not already tried restore points (see Restoring to a previous system restore point on page 86) and partial restores (see Restoring specific files on page 86), try them before using HP Recovery Manager to recover your system.

- A system recovery must be performed if the computer hard drive fails or if all attempts to correct any functional computer issues fail.
• If the recovery media do not work, you can obtain recovery discs for your system from the HP website.

• The Minimized Image Recovery option is recommended for advanced users only. All hardware-related drivers and software are re-installed, but other software applications are not. Do not interrupt the process until it is complete, otherwise the recovery will fail.

Recovering using HP Recovery partition (select models only)

The HP Recovery partition (select models only), allows you to restore your system without the need for recovery discs or a recovery flash drive. This type of recovery can only be used if the hard drive is still working.

To check for the presence of a recovery partition, select Start, right-click Computer then select Manage > Disk Management. If the recovery partition is present, a Recovery drive is listed in the window.

NOTE: Recovery discs have been included if your computer did not ship with a recovery partition.

1. Access HP Recovery Manager in either of the following ways:
   • Select Start and type recovery in the search field. Select Recovery Manager from the list.
   – or –
   • Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the screen. Then press f11 while the “F11 (System Recovery)” message is displayed on the screen.

2. Click System Recovery in the HP Recovery Manager window.

3. Follow the on-screen instructions.

Recovering using the recovery media

1. If possible, back up all personal files.

2. Insert the first recovery disc into the optical drive on your computer or an optional external optical drive, and then restart the computer.
   – or –
   Insert the recovery flash drive into a USB port on your computer, and then restart the computer.

   NOTE: If the computer does not automatically restart in HP Recovery Manager, change the computer boot order. See Changing the computer boot order on page 87.

3. Press f9 at system bootup.

4. Select the optical drive or the flash drive.

5. Follow the on-screen instructions.

Changing the computer boot order

To change the boot order for recovery discs:

1. Restart the computer.

2. Press esc while the computer is restarting, and then press f9 for boot options.

3. Select Internal CD/DVD ROM Drive from the boot options window.
To change the boot order for a recovery flash drive:

1. Insert the flash drive into a USB port.
2. Restart the computer.
3. Press `esc` while the computer is restarting, and then press `f9` for boot options.
4. Select the flash drive from the boot options window.
8 Power cord set requirements

The wide-range input feature of the computer permits it to operate from any line voltage from 100 to 120 V ac, or from 220 to 240 V ac.

The 3-conductor power cord set included with the computer meets the requirements for use in the country or region where the equipment is purchased.

Power cord sets for use in other countries or regions must meet the requirements of the country and region where the computer is used.

Requirements for all countries

The following requirements are applicable to all countries and regions:

- The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).
- All power cord sets must be approved by an acceptable accredited agency responsible for evaluation in the country or region where the power cord set will be used.
- The power cord sets must have a minimum current capacity of 10 A and a nominal voltage rating of 125 or 250 V ac, as required by the power system of each country or region.
- The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320 Standard Sheet C13 connector for mating with the appliance inlet on the back of the computer.
## Requirements for specific countries and regions

<table>
<thead>
<tr>
<th>Country/region</th>
<th>Accredited agency</th>
<th>Applicable note number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Argentina</td>
<td>IRAM</td>
<td>1</td>
</tr>
<tr>
<td>Australia</td>
<td>SAA</td>
<td>1</td>
</tr>
<tr>
<td>Austria</td>
<td>OVE</td>
<td>1</td>
</tr>
<tr>
<td>Belgium</td>
<td>CEBEC</td>
<td>1</td>
</tr>
<tr>
<td>Brazil</td>
<td>ABNT</td>
<td>1</td>
</tr>
<tr>
<td>Canada</td>
<td>CSA</td>
<td>2</td>
</tr>
<tr>
<td>Chile</td>
<td>IMQ</td>
<td>1</td>
</tr>
<tr>
<td>Denmark</td>
<td>DEMKO</td>
<td>1</td>
</tr>
<tr>
<td>Finland</td>
<td>FIMKO</td>
<td>1</td>
</tr>
<tr>
<td>France</td>
<td>UTE</td>
<td>1</td>
</tr>
<tr>
<td>Germany</td>
<td>VDE</td>
<td>1</td>
</tr>
<tr>
<td>India</td>
<td>ISI</td>
<td>1</td>
</tr>
<tr>
<td>Israel</td>
<td>SII</td>
<td>1</td>
</tr>
<tr>
<td>Italy</td>
<td>IMQ</td>
<td>1</td>
</tr>
<tr>
<td>Japan</td>
<td>JIS</td>
<td>3</td>
</tr>
<tr>
<td>The Netherlands</td>
<td>KEMA</td>
<td>1</td>
</tr>
<tr>
<td>New Zealand</td>
<td>SANZ</td>
<td>1</td>
</tr>
<tr>
<td>Norway</td>
<td>NEMKO</td>
<td>1</td>
</tr>
<tr>
<td>The People's Republic of China</td>
<td>CCC</td>
<td>4</td>
</tr>
<tr>
<td>Saudi Arabia</td>
<td>SASO</td>
<td>7</td>
</tr>
<tr>
<td>Singapore</td>
<td>PSB</td>
<td>1</td>
</tr>
<tr>
<td>South Africa</td>
<td>SABS</td>
<td>1</td>
</tr>
<tr>
<td>South Korea</td>
<td>KTL</td>
<td>5</td>
</tr>
<tr>
<td>Sweden</td>
<td>SEMKO</td>
<td>1</td>
</tr>
<tr>
<td>Switzerland</td>
<td>SEV</td>
<td>1</td>
</tr>
<tr>
<td>Taiwan</td>
<td>BSMI</td>
<td>6</td>
</tr>
<tr>
<td>Thailand</td>
<td>TISI</td>
<td>1</td>
</tr>
<tr>
<td>The United Kingdom</td>
<td>ASTA</td>
<td>1</td>
</tr>
<tr>
<td>Country/region</td>
<td>Accredited agency</td>
<td>Applicable note number</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------------</td>
<td>------------------------</td>
</tr>
<tr>
<td>The United States</td>
<td>UL</td>
<td>2</td>
</tr>
</tbody>
</table>

1. The flexible cord must be Type H05VV-F, 3-conductor, 0.75 mm² conductor size. Power cord set fittings (appliance coupler and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it will be used.

2. The flexible cord must be Type SVT/SJT or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole grounding type with a NEMA 5-15P (15 A, 125 V ac) or NEMA 6-15P (15 A, 250 V ac) configuration. CSA or C-UL mark. UL file number must be on each element.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the Japanese Dentori Law. The flexible cord must be Type VCTF, 3-conductor, 0.75 mm² or 1.25 mm² conductor size. The wall plug must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V ac) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75 mm² conductor size. Power cord set fittings (appliance coupler and wall plug) must bear the CCC certification mark.

5. The flexible cord must be Type H05VV-F 3-conductor, 0.75 mm² conductor size. KTL logo and individual approval number must be on each element. Corset approval number and logo must be printed on a flag label.

6. The flexible cord must be Type HVCTF 3-conductor, 1.25 mm² conductor size. Power cord set fittings (appliance coupler, cable, and wall plug) must bear the BSMI certification mark.

7. For 127 V ac, the flexible cord must be Type SVT or SJT 3-conductor, 18 AWG, with plug NEMA 5-15P (15 A, 125 V ac), with UL and CSA or C-UL marks. For 240 V ac, the flexible cord must be Type H05VV-F 3-conductor, 0.75 mm² or 1.00 mm² conductor size, with plug BS 1363/A with BSI or ASTA marks.
When a battery has reached the end of its useful life, do not dispose of the battery in general household waste. Follow the local laws and regulations in your area for battery disposal. HP encourages customers to recycle used electronic hardware, HP original print cartridges, and rechargeable batteries.

For more information about recycling programs, see the HP website at [www.hp.com/recycle](http://www.hp.com/recycle).
# Index

## A
- AC adapter 11
- AC adapter, spare part numbers 20, 21
- action keys
  - identifying 7
- antenna
  - locations 5
  - removal 61
  - spare part number 18, 22, 61
- Antenna Kit, spare part number 18, 22, 61
- audio, product description 2
- audio-in (microphone) jack 10
- audio-out (headphone) jack 10

## B
- backups 83
- base enclosure, spare part number 16, 22
- battery
  - removal 31
  - spare part numbers 16, 21, 31
- battery bay 12
- battery release latch 12
- Blu-ray Disc (BD) ROM and DVD ±R/RW SuperMulti Double-Layer Drive
  - specifications 82
- Blu-ray ROM DVD±R/RW Super Multi Double-Layer Drive
  - precautions 25
  - removal 33
  - spare part numbers 17, 19, 23, 33
- boot order
  - changing 87
- bottom components 12
- button component 6
- buttons
  - left TouchPad 9
  - optical drive eject 11
  - power 6
  - right TouchPad 9
  - TouchPad on/off 9

## C
- cable kit 61
- cables, service considerations 24
- caps lock light, identifying 8
- chipset, product description 1
- components
  - bottom 12
  - button 6
  - display 5
  - keys 7
  - left side 10
  - lights 8
  - right side 11
  - TouchPad 9
- computer feet
  - locations 30
  - spare part number 16, 23, 30
- computer major components 14
- computer specifications 79
- connector, power 11
- connectors, service considerations 24

## D
- deleted files
  - restoring 86
- Digital Media Slot, identifying 10
- display assembly
  - removal 54
  - spare part numbers 15, 23, 54
  - subcomponents 18
- display bezel
  - removal 56
  - spare part number 18, 22, 56
- display components 5
- display enclosure, spare part numbers 18
- Display Hinge Kit, spare part number 18, 22, 60
- display panel
  - product description 1
  - removal 58
  - spare part number 18, 23, 61
  - display panel cable removal 60
    - spare part number 18, 22, 59, 60
- Display Panel Cable Kit, spare part number 18, 22, 60
- Display Screw Kit, spare part number 18, 23
- display specifications 80
- drives, preventing damage 25
- DVD±RW and CD-RW Super Multi Double-Layer Combo Drive
  - precautions 25
  - removal 33
  - spare part numbers 33
- DVD±RW and CD-RW SuperMulti Double-Layer Combo Drive
  - specifications 81
- DVD±RW Super Multi Double-Layer Combo Drive
  - spare part numbers 17, 19, 22

## E
- electrostatic discharge 25
- equipment guidelines 28
- esc key, identifying 7
- Ethernet, product description 2
- external media cards, product description 3
- external monitor port 10

## F
- fan
  - removal 68
  - spare part number 16, 22, 68
- feet
  - locations 30
  - spare part number 16, 23, 30
- fn key, identifying 7

## G
- graphics, product description 1
- grounding guidelines 25
- guidelines
  - equipment 28
<table>
<thead>
<tr>
<th>H</th>
<th>hard drive</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>precautions 25</td>
</tr>
<tr>
<td></td>
<td>product description 2</td>
</tr>
<tr>
<td></td>
<td>removal 36</td>
</tr>
<tr>
<td></td>
<td>spare part numbers 16, 19, 36</td>
</tr>
<tr>
<td></td>
<td>specifications 80</td>
</tr>
<tr>
<td>H</td>
<td>hard drive bay, identifying 12</td>
</tr>
<tr>
<td>H</td>
<td>hard drive bracket, illustrated 19</td>
</tr>
<tr>
<td>H</td>
<td>hard drive bumper</td>
</tr>
<tr>
<td></td>
<td>illustrated 19</td>
</tr>
<tr>
<td>H</td>
<td>Hard Drive Hardware Kit, spare part number 16, 19, 23, 36</td>
</tr>
<tr>
<td>H</td>
<td>hard drive light 11</td>
</tr>
<tr>
<td>H</td>
<td>HDMI port, identifying 10</td>
</tr>
<tr>
<td>H</td>
<td>heat sink</td>
</tr>
<tr>
<td></td>
<td>removal 68</td>
</tr>
<tr>
<td></td>
<td>spare part numbers 22, 68</td>
</tr>
<tr>
<td>H</td>
<td>hinge</td>
</tr>
<tr>
<td></td>
<td>removal 59</td>
</tr>
<tr>
<td></td>
<td>spare part number 18, 22, 60</td>
</tr>
<tr>
<td>H</td>
<td>hinge cover</td>
</tr>
<tr>
<td></td>
<td>removal 57</td>
</tr>
<tr>
<td></td>
<td>spare part number 18, 22, 57</td>
</tr>
<tr>
<td>H</td>
<td>HP Recovery Manager 86</td>
</tr>
<tr>
<td>I</td>
<td>internal media card, product description 3</td>
</tr>
<tr>
<td>J</td>
<td>jack</td>
</tr>
<tr>
<td></td>
<td>audio-in (microphone) 10</td>
</tr>
<tr>
<td></td>
<td>audio-out (headphone) 10</td>
</tr>
<tr>
<td>J</td>
<td>jacks</td>
</tr>
<tr>
<td></td>
<td>network 10</td>
</tr>
<tr>
<td></td>
<td>RJ-45 (network) 10</td>
</tr>
<tr>
<td>K</td>
<td>key components 7</td>
</tr>
<tr>
<td></td>
<td>keyboard</td>
</tr>
<tr>
<td></td>
<td>product description 3</td>
</tr>
<tr>
<td></td>
<td>removal 43</td>
</tr>
<tr>
<td></td>
<td>spare part numbers 15, 22, 43</td>
</tr>
<tr>
<td>K</td>
<td>keys</td>
</tr>
<tr>
<td></td>
<td>action 7</td>
</tr>
<tr>
<td></td>
<td>esc 7</td>
</tr>
<tr>
<td></td>
<td>fn 7</td>
</tr>
<tr>
<td></td>
<td>Operating system</td>
</tr>
<tr>
<td></td>
<td>applications 7</td>
</tr>
<tr>
<td></td>
<td>operating system logo 7</td>
</tr>
<tr>
<td></td>
<td>Windows applications 7</td>
</tr>
<tr>
<td></td>
<td>Windows logo 7</td>
</tr>
<tr>
<td>L</td>
<td>latch, battery release 12</td>
</tr>
<tr>
<td>L</td>
<td>left-side components 10</td>
</tr>
<tr>
<td>L</td>
<td>light components 8</td>
</tr>
<tr>
<td>L</td>
<td>lights</td>
</tr>
<tr>
<td></td>
<td>AC adapter 11</td>
</tr>
<tr>
<td></td>
<td>caps lock 8</td>
</tr>
<tr>
<td></td>
<td>hard drive 11</td>
</tr>
<tr>
<td></td>
<td>mute 8</td>
</tr>
<tr>
<td></td>
<td>optical drive 11</td>
</tr>
<tr>
<td></td>
<td>power 8, 11</td>
</tr>
<tr>
<td></td>
<td>TouchPad 8, 9</td>
</tr>
<tr>
<td></td>
<td>webcam 5</td>
</tr>
<tr>
<td></td>
<td>wireless 8</td>
</tr>
<tr>
<td>M</td>
<td>mass storage device</td>
</tr>
<tr>
<td></td>
<td>precautions 25</td>
</tr>
<tr>
<td></td>
<td>removal 36</td>
</tr>
<tr>
<td></td>
<td>spare part numbers 19, 36</td>
</tr>
<tr>
<td>M</td>
<td>memory module</td>
</tr>
<tr>
<td></td>
<td>product description 1</td>
</tr>
<tr>
<td></td>
<td>removal 38</td>
</tr>
<tr>
<td></td>
<td>spare part numbers 16, 21, 38</td>
</tr>
<tr>
<td>M</td>
<td>memory module compartment, identifying 12</td>
</tr>
<tr>
<td>M</td>
<td>microphone</td>
</tr>
<tr>
<td></td>
<td>location 5</td>
</tr>
<tr>
<td></td>
<td>product description 2</td>
</tr>
<tr>
<td>M</td>
<td>model name 1</td>
</tr>
<tr>
<td>M</td>
<td>mute light, identifying 8</td>
</tr>
<tr>
<td>N</td>
<td>network jack, identifying 10</td>
</tr>
<tr>
<td>O</td>
<td>Operating system applications key, identifying 7</td>
</tr>
<tr>
<td>O</td>
<td>operating system logo identifying 7</td>
</tr>
<tr>
<td>O</td>
<td>operating system, product description 4</td>
</tr>
<tr>
<td>O</td>
<td>optical drive</td>
</tr>
<tr>
<td></td>
<td>precautions 25</td>
</tr>
<tr>
<td></td>
<td>product description 2</td>
</tr>
<tr>
<td></td>
<td>removal 33</td>
</tr>
<tr>
<td></td>
<td>spare part numbers 17, 19, 33</td>
</tr>
<tr>
<td></td>
<td>specifications 81, 82</td>
</tr>
<tr>
<td>O</td>
<td>optical drive bracket, removal 34</td>
</tr>
<tr>
<td>O</td>
<td>optical drive cable</td>
</tr>
<tr>
<td></td>
<td>removal 61</td>
</tr>
<tr>
<td>O</td>
<td>optical drive eject button, identifying 11</td>
</tr>
<tr>
<td>O</td>
<td>optical drive light, identifying 11</td>
</tr>
<tr>
<td>O</td>
<td>optical drive, identifying 11</td>
</tr>
<tr>
<td>O</td>
<td>original system recovery 86</td>
</tr>
<tr>
<td>P</td>
<td>packaging guidelines 27</td>
</tr>
<tr>
<td>P</td>
<td>PCH heat sink</td>
</tr>
<tr>
<td></td>
<td>removal 71</td>
</tr>
<tr>
<td></td>
<td>spare part number 71</td>
</tr>
<tr>
<td>P</td>
<td>plastic parts, service considerations 24</td>
</tr>
<tr>
<td>P</td>
<td>plastics kit 32</td>
</tr>
<tr>
<td>P</td>
<td>Plastics Kit, spare part number 17, 23</td>
</tr>
<tr>
<td>P</td>
<td>pointing device, product description 3</td>
</tr>
<tr>
<td>P</td>
<td>ports</td>
</tr>
<tr>
<td></td>
<td>external monitor 10</td>
</tr>
<tr>
<td></td>
<td>HDMI 10</td>
</tr>
<tr>
<td></td>
<td>USB 2.0 11</td>
</tr>
<tr>
<td></td>
<td>USB 3.0 10</td>
</tr>
<tr>
<td>P</td>
<td>ports, product description 3</td>
</tr>
<tr>
<td>P</td>
<td>power button board</td>
</tr>
<tr>
<td></td>
<td>removal 50</td>
</tr>
<tr>
<td></td>
<td>spare part number 15, 23, 50</td>
</tr>
<tr>
<td>P</td>
<td>power button, identifying 6</td>
</tr>
<tr>
<td>P</td>
<td>power connector cable</td>
</tr>
<tr>
<td></td>
<td>removal 64</td>
</tr>
<tr>
<td></td>
<td>spare part number 16, 22</td>
</tr>
<tr>
<td>P</td>
<td>power connector, identifying 11</td>
</tr>
<tr>
<td>P</td>
<td>power cord</td>
</tr>
<tr>
<td></td>
<td>requirements for all countries 89</td>
</tr>
<tr>
<td>P</td>
<td>requirements for specific countries and regions 90</td>
</tr>
<tr>
<td>P</td>
<td>set requirements 89</td>
</tr>
<tr>
<td>P</td>
<td>spare part numbers 20, 21</td>
</tr>
<tr>
<td>P</td>
<td>power lights, identifying 8, 11</td>
</tr>
</tbody>
</table>
power requirements, product description 3
processor
removal 72
spare part numbers 16, 21, 72
processors, product description 1
product description
audio 2
chipset 1
display panel 1
Ethernet 2
external media cards 3
graphics 1
hard drives 2
internal media card 3
keyboard 3
memory module 1
microphone 2
operating system 4
optical drive 2
pointing device 3
ports 3
power requirements 3
processors 1
product name 1
security 4
serviceability 4
video 2
wireless 2
product name 1

R
recovering from the recovery discs 87
recovering the original system 86
recovery 86
HP Recovery Manager 86
recovery discs 83
recovery media 83
recovery, system 86
recycling 92
removal/replacement
preliminaries 24
procedures 28
restore points 84
restoring the original system
creating recovery media 83
right-side components 11
RJ-45 (network) jack, identifying 10
RTC battery
removal 67
spare part number 16, 21, 67
Rubber Feet Kit, spare part number 16, 23, 30
S
Screw Kit, spare part number 20, 23
security cable slot, identifying 11
security, product description 4
service considerations
cables 24
connectors 24
plastic parts 24
service door
removal 32
spare part number 17, 32
service label 13, 29
serviceability, product description 4
Setup Utility (BIOS) 74
slots
Digital Media 10
security cable 11
Speaker Kit, spare part number 15, 23, 49
speakers
removal 49
spare part number 15, 23, 49
speakers, identifying 6
specifications
Blu-ray Disc (BD) ROM and DVD±R/RW SuperMulti Double-Layer Drive 82
computer 79
display 80
DVD±RW and CD-RW SuperMulti Double-Layer Combo Drive 81
hard drive 80
optical drive 81, 82
supported discs 83
system board
removal 65
spare part numbers 15, 23, 65
System Diagnostics 74
system recovery 86
system restore points 84
creating 84
T
tools required 24
top cover
removal 46
spare part numbers 15, 23, 46
TouchPad
buttons 9
TouchPad button board
removal 51
spare part number 15, 23, 51
TouchPad components 9
TouchPad LED board
removal 52
spare part number 15, 23, 52
TouchPad light 9
TouchPad on/off button 9
TouchPad reader light 8
TouchPad zone, identifying 9
transporting guidelines 27
U
USB 2.0 ports, identifying 11
USB 3.0 ports, identifying 10
USB board
removal 63
spare part number 16, 23
V
vents, identifying 10, 12
video, product description 2
W
webcam light 5
webcam, location 5
webcam/microphone module
removal 56
spare part number 18, 23, 57
Windows applications key, identifying 7
Windows Backup and Restore
restoring files 86
Windows logo key, identifying 7
wireless antenna
locations 5
removal 61
spare part number 18, 22, 61
wireless light 8
wireless module compartment, identifying 12
wireless, product description 2
WLAN module
removal  41
spare part numbers  17, 21,
  22, 41
workstation guidelines 27